Manual Part No. 28-0287

October, 2014

Copyright © 2000–2014 Harmonic Inc. All rights reserved. Omneon, and the Omneon logo are trademarks of Harmonic Inc.

Disclaimer
Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Trademark Acknowledgments
Harmonic and all Harmonic product names are trademarks of Harmonic Inc. All other trademarks are the property of their respective owners.

The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms of those agreements.

May be covered by one or more of U.S. Patents No. 6,571,351; 6,696,996; 6,545,721; 6,574,225; 6,895,003; 6,522,649; 6,643,702; foreign counterparts and pending patent applications.

This system is distributed with certain other software that may require disclosure or distribution of licenses, copyright notices, conditions of use, disclaimers and/or other matter. Use of this system or otherwise fulfilling their conditions constitutes your acceptance of them, as necessary. Copies of such licenses, notices, conditions, disclaimers and/or other matter are available in any one of the following locations: the LEGAL NOTICES AND LICENSES directory of the distribution disk of the software, the root directory of the hard disk drive of the Products, or by contacting us at support@harmonicinc.com.

Notice
Information contained in this guide is subject to change without notice or obligation. While every effort has been made to ensure that the information is accurate as of the publication date, Harmonic Inc. assumes no liability for errors or omissions. In addition, Harmonic Inc. assumes no responsibility for damages resulting from the use of this guide.

License Agreement and Limited Warranty
1. AGREEMENT: This is a legal agreement ("Agreement") between you ("you" or "your") and Harmonic, or its appropriate local affiliate ("Harmonic", "we", "us" or "our"). Use of our product(s) and any updates thereto purchased or validly obtained by you the "Products"), and/or the Software (as defined below) collectively, the "System"), constitutes your acceptance of this Agreement. "Use" includes opening or breaking the seal on the packet containing this Agreement, installing or downloading the Software as defined below or using the Software preloaded or embedded in your System. As used herein, the term "Software" means the Harmonic owned software and/or firmware used in or with the Products and embedded into, provided with or loaded onto the Products in object code format, but does not include, and this Agreement does not address, any third-party or open source software separately licensed to you ("Third Party Software"). If you do not agree to this Agreement, you shall promptly return the System with a dated receipt to the seller for a full refund.

2. LICENSE: Subject to the terms and conditions of this Agreement, including payments, we hereby grant you a nonexclusive, nontransferable license to use the object code version of the Software embedded into, provided solely for use with or loaded onto the Product, and the accompanying documentation ("Documentation") for your internal business purposes. The Software and any authorized copies are owned by us or our suppliers, and are protected by law, including without limitation the copyright laws and treaties of the U.S.A. and other countries. Evaluation versions of the Software may be subject to a time-limited license key.

3. RESTRICTIONS. You and your employees and contractors shall not attempt to reverse engineer, disassemble, modify, translate, create derivative works of, rent, lease (including use on a timesharing, applications service provider, service bureau or similar basis), loan, distribute, sublicense or otherwise transfer the System, in whole or part except to the extent otherwise permitted by law. The Software may be operated on a network only if and as permitted by its Documentation. You may make one (1) back up copy of the object code of the Software for archival purposes only. Evaluation Software will run in a lab, nonproductive environment. Results of any benchmark or other performance tests may not be disclosed to any third party without our prior written consent.

4. LIMITED WARRANTY: (a) Limited Warranty. We warrant to you that, commencing on your receipt of a Product and terminating 1 year thereafter, the System will perform substantially in accordance with its then-current appropriate Documentation. The Product including replacements may consist of new, used or previously installed components. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System's remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AN AS-IS BASIS AND SUBJECT TO 4(d). We will have no obligation under this limited warranty due to: (i) negligence, misuse or abuse of the System, such as unusual physical or electrical stress, misuse or accidents; (ii) use of the System other than in accordance with the Documentation; (iii) modifications, alterations or repairs to the System made by a party other than us or our representative; (iv) the combination, operation or use of the System with equipment, devices, software or data not supplied by us; (v) any third party hardware or Third Party Software, whether or not provided by us; (vi) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, temperature or humidity ranges; (d) Disclaimers. We are not responsible for your software, firmware, information, or data contained in, stored on, or integrated with any Product returned to us for repair or replacement. SUCH
LIMITED WARRANTY IS IN LIEU OF, AND WE SPECIFICALLY DISCLAIM, ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF SATISFACTORY QUALITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. WE DO NOT WARRANT THAT THE SYSTEM WILL MEET YOUR REQUIREMENTS OR BE UNINTERRUPTED OR ERROR-FREE. NO ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED FROM US OR ELSEWHERE, WILL CREATE ANY WARRANTY NOT EXPRESSLY STATED IN THIS AGREEMENT. Some jurisdictions do not allow the exclusion of implied warranties or limited warranties, so the above exclusions may not apply to you. In that event, such implied warranties or limitations are limited to 60 days from the date you purchased the System or the shortest period permitted by applicable law, if longer. This warranty gives you specific legal rights and you may have other rights which vary from state to state or country to country.

5. LIMITATION OF LIABILITY: WE AND OUR AFFILIATES, SUPPLIERS, LICENSORS, OR SALES CHANNELS (“REPRESENTATIVES”) SHALL NOT BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND, INCLUDING BUT NOT LIMITED TO LOST REVENUES, PROFITS OR SAVINGS, OR THE COST OF SUBSTITUTE GOODS, HOWEVER CAUSED, UNDER CONTRACT, TORT, BREACH OF WARRANTY, NEGLIGENCE, OR OTHERWISE, EVEN IF WE WERE ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGES. NOTWITHSTANDING ANY OTHER PROVISIONS OF THIS AGREEMENT, WE AND OUR REPRESENTATIVES’ TOTAL LIABILITY TO YOU ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SYSTEM SHALL BE LIMITED TO THE TOTAL PAYMENTS TO US UNDER THIS AGREEMENT FOR THE SYSTEM. THE FOREGOING LIMITATIONS SHALL NOT APPLY TO DEATH OR PERSONAL INJURY TO PERSONS OR TANGIBLE PROPERTY IN ANY JURISDICTION WHERE APPLICABLE LAW PROHIBITS SUCH LIMITATION. YOU ARE SOLELY RESPONSIBLE FOR BACKING UP YOUR DATA AND FILES, AND HEREBY RELEASE US AND OUR REPRESENTATIVES FROM ANY LIABILITY OR DAMAGES DUE TO THE LOSS OF ANY SUCH DATA OR FILES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH EXCLUSIONS MAY NOT APPLY TO YOU.

6. CONFIDENTIALITY: Information in the System and the associated media, as well as the structure, organization and code of the Software, are proprietary to us and contain valuable trade secrets developed or acquired at great expense to us or our suppliers. You shall not disclose to others or utilize any such information except as expressly provided herein, except for information (i) lawfully received by the user from a third party which is not subject to confidentiality obligations, (ii) generally available to the public without breach of this Agreement, (iii) lawfully known to the user prior to its receipt of the System, or (iv) required by law to be disclosed.

7. SUPPORT: Updates, upgrades, fixes, maintenance or support for the System (an “Upgrade”) after the limited warranty period may be available at separate terms and fees from us. Any Upgrade shall be subject to this Agreement, except for additional or inconsistent terms we specify. Upgrades do not extend the limited warranty period.

8. TERM; TERMINATION: The term of this Agreement shall continue unless terminated in accordance with this Section. We may terminate this Agreement at any time upon default by you of the license provisions of this Agreement, or any other material default by you of this Agreement not cured within thirty (30) days after written notice thereof. You may terminate this Agreement any time by terminating use of the System. Except for the first sentence of Section 2 (“License”) and for Section 4(a) (“Limited Warranty”), all provisions of this Agreement shall survive termination of this Agreement. Upon any such termination, you shall certify in writing such termination and non-use to us.

9. EXPORT CONTROL: You agree that the Products and Software will not be shipped, transferred, or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations (“Export Laws”). You will indemnify, defend, and hold us harmless from any and all claims arising therefrom or relating thereto. In addition, if the Products or Software are identified as export controlled items under the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. All rights to the Products and Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

10. U.S. GOVERNMENT RIGHTS: The Software and the documentation which accompanies the Software are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government as end users (i) only as Commercial Items and (ii) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Harmonic, 4300 North First Street, San Jose, CA 95134 U.S.A.

11. GENERAL: You shall not assign, delegate or sublicense your rights or obligations under this Agreement, by operation of law or otherwise, without our prior written consent, and any attempt without such consent shall be void. Subject to the preceding sentence, this Agreement binds and benefits permitted successors and assigns. This Agreement is governed by California law, without regard to its conflicts of law principles. The U.N. Convention on Contracts for the International Sale of Goods is disclaimed. If any claim arises out of this Agreement, the parties hereby submit to the exclusive jurisdiction and venue of the federal and state courts located in Santa Clara County, California. In addition to any other rights or remedies, we shall be entitled to injunctive and other equitable relief, without posting bond or other security, to prevent any material breach of this Agreement. We may change the terms, conditions and pricing relating to the future licensing of our Systems and other intellectual property rights, including this Agreement, from time to time. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, the remaining parts will be enforced to the maximum extent permitted. There are no third-party beneficiaries to this Agreement. We are not bound by additional and/or conflicting provisions in any order, acceptance, or other correspondence unless we expressly agree in writing. This Agreement is the complete and exclusive statement of agreement between the parties as to its subject matter and supersedes all proposals or prior agreements, verbal or written, advertising, representations or communications concerning the System.

Every reasonable attempt has been made to comply with all licensing requirements for all components used in the system. Any oversight is unintentional and will be remedied if brought to the attention of Harmonic at support@harmonicinc.com.

© 2014 Harmonic Inc. All rights reserved.
Documentation Conventions

This guide may use some special symbols and fonts to call your attention to important information. The following symbols appear throughout this guide:

**DANGER:** The Danger symbol calls your attention to information that, if ignored, can cause physical harm to you.

**CAUTION:** The Caution symbol calls your attention to information that, if ignored, can adversely affect the performance of your Harmonic product, or that can make a procedure needlessly difficult.

**LASER DANGER:** The Laser symbol and the Danger alert call your attention to information about the lasers in this product that, if ignored, can cause physical harm to you.

**NOTE:** The Note symbol calls your attention to additional information that you will benefit from heeding. It may be used to call attention to an especially important piece of information you need, or it may provide additional information that applies in only some carefully delineated circumstances.

**IMPORTANT:** The Important symbol calls your attention to information that should stand out when you are reading product details and procedural information.

**TIP:** The Tip symbol calls your attention to parenthetical information that is not necessary for performing a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, smoother, or more efficient.

In addition to these symbols, this guide may use the following text conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typed Command</strong></td>
<td>Indicates the text that you type in at the keyboard prompt.</td>
</tr>
<tr>
<td><code>&lt;Ctrl&gt;, &lt;Ctrl&gt;+&lt;Shift&gt;</code></td>
<td>A key or key sequence to press.</td>
</tr>
<tr>
<td><strong>Links</strong></td>
<td>The <em>italics in blue</em> text to indicate Cross-references, and hyperlinked cross-references in online documents.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Indicates a button to click, or a menu item to select.</td>
</tr>
<tr>
<td><strong>ScreenOutput</strong></td>
<td>The text that is displayed on a computer screen.</td>
</tr>
<tr>
<td><strong>Emphasis</strong></td>
<td>The <em>italics</em> text used for emphasis and document references.</td>
</tr>
</tbody>
</table>

**NOTE:** You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can download Adobe Reader free of charge from www.adobe.com.
Chapter 7: Playing Out Clips .................................................. 71
In this Chapter ................................................................. 71
Overview ........................................................................ 71
Enabling a Player for Playout .............................................. 71
Understanding the Playout Window ..................................... 74
  Controls ........................................................................ 74
  Buttons ......................................................................... 77
  Menus .......................................................................... 78
Understanding the Playout List Text File ............................ 78
Managing Playlists .............................................................. 79
  Opening Playlists .......................................................... 79
  Appendixing Playlists .................................................... 79
  Saving Playlists ............................................................ 80
  Clearing Playlists .......................................................... 80
  About Status Updates to the Playlist ............................... 80
Managing Playout Events .................................................. 81
  Creating Playout Events ............................................... 81
  Editing Playout Events .................................................. 82
  Copying and Pasting Playout Events ............................... 83
  Cutting Playout Events .................................................. 83
  Deleting Playout Events ............................................... 83
  Selecting All Playout Events ......................................... 83
Playing Clips .................................................................. 83

Chapter 8: Managing Clips .................................................. 85
In this Chapter ................................................................. 85
Overview ........................................................................ 85
Understanding the Clip Management Window ..................... 85
  Menus .......................................................................... 86
Viewing Clips ................................................................ 87
  Filtering Clips .............................................................. 87
  Viewing Clips in a Folder ............................................... 87
  Viewing Clip Properties ................................................. 87
Managing Clips ................................................................ 88
  Selecting Clips .............................................................. 88
  Sorting Clips ................................................................. 89
  Renaming Clips ............................................................. 89
  Copying Clips ............................................................... 89
Contents

Moving Clips .................................................................................................................. 90
Deleting Clips ................................................................................................................. 90
Changing to Complex View ......................................................................................... 90
Adding Custom Metadata to Clip User Data ............................................................... 91
Managing Clip Folders ................................................................................................. 93
  Exploring Folders ........................................................................................................ 93
  Creating Folders .......................................................................................................... 93
  Renaming Folders ....................................................................................................... 94
  Refreshing Folders ..................................................................................................... 94
  Deleting Folders ......................................................................................................... 94

Appendix A: Reference Information .......................................................................... 96
  Clip Preparation Keyboard Commands ....................................................................... 96
  VTR Keyboard Commands .......................................................................................... 97
  List Control Keyboard Commands ............................................................................ 98
  About ProDrive.exe Error Messages and Logs .......................................................... 98
  About the As-Run Log Header List ............................................................................. 99
  About Authentication for MediaDirector 2202 Systems Working with ProDrive ........ 100
  About Fault Handling in ProDrive ............................................................................. 100
  About the Automatic Renaming of Sub Clips Using Clip Patterns ......................... 102

Appendix B: Contacting the Technical Assistance Center ...................................... 104
Chapter 1
Introduction

This guide provides information on how to install and use the Harmonic ProDrive application. Choose from the following sections:

- About Harmonic ProDrive
- Understanding the ProDrive Overview Window
- Locating the Latest Documentation on the Harmonic Web Site

About Harmonic ProDrive

Harmonic ProDrive™ is an integrated media control system for Spectrum™ System and MediaDeck™ broadcast servers, combining ingest, preparation, and clip playout functions for up to six broadcast channels into a single application.

Using ProDrive, you can:

- Control content on your Spectrum or MediaDeck server from anywhere on the network
- Capture content according to a schedule, or use the crash record feature
- Capture content from tapes while simultaneously controlling the source VTR via serial protocol
- Create playout schedules
- Review clips, specify in and out points, and create sub-clips, all from your desktop – or rename, move, copy and delete content

ProDrive supports from one to six simultaneous playout or ingest ports, providing true flexibility to configure the system to meet your requirements.

ProDrive can be installed on any PC computer running Windows XP® or Windows Vista with TCP/IP connectivity to a Spectrum or MediaDeck server.

Powerful Ingest Features

ProDrive provides a range of ingest features for capturing content to your Spectrum Server or MediaDeck and preparing it for transmission.

The Crash record feature allows operators to instantly specify capture content that is being fed to a port. Crash records can run for a specified duration to create a clip on your server. Clips can then be scheduled for playout on another port while being recorded.

ProDrive’s schedule management feature enables users to view, edit and create new scheduled record items at any time of day for any duration. At the specified time, your server will switch to record mode and capture your desired content.

VTR Ingest allow you to capture content from your tapes while simultaneously controlling the source VTR via serial protocol. With VTR Ingest, you can create an ingest list based on the content of a tape, and then capture and digitize all marked sections from that tape. This feature captures content from multi-segment tapes and handles long-form content that spans multiple tapes. Ingest lists can also be created in external applications and imported into ProDrive.
Flexible Clip Preparation

ProDrive provides comprehensive clip preparation to ensure that the content stored on your Spectrum Server or MediaDeck is ready for transmission whenever you need it.

Any clip on your server can be loaded into the ProDrive application and controlled just as if it were a clip on a VTR, using any appropriately configured port on your server. Operators can jog and shuttle through the clip, find points of interest, mark new in and out points, and create new sub-clips based on this data.

Extensive Playout Options

ProDrive provides comprehensive content playout features in the same intuitive user interface. Individual clips (or even sections of clips) can be loaded onto a port and either played out immediately or scheduled for playout at a specific time.

Operators are also able to create playout lists containing multiple clips from your server. ProDrive supports complex transmission rules such as list looping, configuring Auto-follow, Manual, or Hard-timed Events. New clips arriving on the server can immediately be inserted into an active list at any desired location within the list.
ProDrive can also import playlists from PlayTool, making it easy to integrate into existing workflows or other parts of your business.

Full logging of transmission output is provided, making it easy to compare schedules and as-run content – ensuring that what went to air matches what was intended.

Figure 1–3: Clip Playout

Manage Clips Easily

The clip management features in ProDrive help you to manage the content stored on your server. With a full explorer view of the server’s contents, you can rename, move, copy and delete clips, all from your desktop. Even with complex reference or self-contained clips, a consolidated view makes your content manageable and accessible. Folder structures within the server can also be created and organized with ProDrive.
Chapter 1 Introduction

Understanding the ProDrive Overview Window

When the ProDrive application starts, the Overview window displays. This window contains access to all ProDrive configured Players as well as Clip management.

The Overview window is arranged into different groups of controls and displays. From top to bottom, these are the Menu bar, the Players bar, and the Status Panel area.

Figure 1–4: Clip Management

BXF Integration

With release 1.3, ProDrive introduces support for Scheduled Ingest via BXF. For integration details, see Configuring BXF Integration. At this time, BXF support is qualified with the Myers ProTrack* system only.

Summary

Paired with the Harmonic server of your choice, ProDrive provides a complete solution to get you on air quickly and painlessly. Fast to set up and easy to learn and use, it is the ideal companion for your Spectrum or MediaDeck Server.

Understanding the ProDrive Overview Window

When the ProDrive application starts, the Overview window displays. This window contains access to all ProDrive configured Players as well as Clip management.
Status Panels

As you configure Players in ProDrive, panels are added to the Overview window. The panels provide a quick status of all functions currently in operation in ProDrive.
Players Bar

The Players bar, which appears at the top of the Overview window, provides access to all ProDrive functions. The Overview and Clip Management buttons always appear in the window. Other buttons, one for each configured Player, only appear after you configure that Player for a specific role of either Playout, VTR Ingest, Clip Prep, or Scheduled Ingest. The buttons can be configured with a name and graphic of your choice.
Locating the Latest Documentation on the Harmonic Web Site

The latest product technical documentation, as well as information provided for older releases, is available at:

http://www.harmonicinc.com/services-support
Chapter 2
Installing ProDrive

In this Chapter

- System Requirements
- System Compatibility
- What Gets Installed
- Installing ProDrive
- About ProDrive Licensing
- About the Media API DLL and ProDrive

System Requirements

Prior to installing ProDrive, your PC must conform to the following minimum requirements, and must be connected via Ethernet to your facility’s LAN:

- 2.4 GHz Pentium 4 or equivalent CPU
- 256 megabytes (MB) of RAM
- 1 gigabyte (GB) hard drive, or the minimum required for your operating system
- At least 30 megabytes of free disk space
- Windows XP, or Windows Vista ®
- Display resolution should be set to 1024 x 768 minimum
- Network access to a media server and SystemManager PC
- A Sony RS 422-compatible VTR with at least 1 serial com port (for the VTR Ingest feature only)

Cable Requirement for VTR Ingest

A VTR control cable is required to connect a VTR to MediaPorts associated with Players controlled by ProDrive. Harmonic has qualified and validated the USB to RS-422 control cable available from Addenda Electronics for use with ProDrive. You can purchase the RS-USB/4 product directly from http://www.addenda.com/addenda-elec/products/rsUSB4.php or from other retailers.

System Compatibility

ProDrive is compatible with Spectrum™ System software version 5.4 or later.

What Gets Installed

The application consists of a ProDrive installer, packaged in a .zip file. The .zip file also include a PDF of this guide.
Installing ProDrive

IMPORTANT: When updating from a prior release, Harmonic recommends that you completely uninstall ProDrive before installing ProDrive 1.3.

To install:
1. Log on to the computer on which you want to install ProDrive.

NOTE: During the installation process, an Omneon\ProDrive directory is created in the user's Application Data directory. You will need read and write permissions to this directory to complete the installation.

2. If you have not already done so, open the ProDrive.zip folder that you downloaded from the Harmonic support Web site and extract the files using the password provided by Technical Support. Contact Technical Support for assistance.

3. Locate the ProDrive-installer.exe file icon.

4. Double-click the ProDrive-installer.exe icon to begin the installation.

5. Click Yes to continue.

6. When the setup wizard launches, click Next and then follow the installation steps to install ProDrive.
7. Click the agreement radio button and then **Next**.

![Figure 2–4: ProDrive Destination](image)

8. Click **Next** to select the default destination location. By default, the application is installed to:
   - C:\Program Files\Omneon\Prodrive for Windows XP
   - C:\Program Files(x86)\Omneon\Prodrive for Windows 7

![Figure 2–5: ProDrive Shortcut](image)

9. Click **Next** to create the shortcut key.
10. Click **Finish** when installation is complete.

### About ProDrive Licensing

When ProDrive is first installed, it will operate as an “Evaluation Copy”. The evaluation copy allows you to view some of the screens and dialogs of the software. You must, however, install a license to be able to ingest, edit, or playout media clips.

If you wish to launch ProDrive for evaluation purposes and do not yet have a valid license, do the following:

1. Launch the ProDrive application. You may encounter three different messages if you don’t have the correct configuration. Click **OK** in these message boxes and contact Harmonic for help:
   a. If you don’t have a valid license, you will see:

      ![Figure 2–7: No Valid Licenses](image)

      **Figure 2–7: No Valid Licenses**

   b. If the Advantech driver is not installed, ProDrive will report an error upon start up. Either install the driver if GPI control is required, or, click the **Don’t show this message again** message checkbox in the dialog window.
Chapter 2 Installing ProDrive

Harmonic Inc. All rights reserved. ProDrive™ 1.3

Figure 2–8: No Driver Installed Error

c. If the commedia.dll file cannot be located, you will see:

Figure 2–9: No File Found

2. Click OK. The ProDrive Configuration window appears as shown below.
Figure 2–10: Configuration Window

**NOTE:** The GPI Device box displays when your computer is connected to a GPI Device.

If this is a new installation, the **Not Connected** message displays in the bottom right hand corner of the Overview screen. This occurs because the application cannot access the prodrive.cfg file, since it does not yet exist. Enter the Samba IP address of the Spectrum server and define the root directory, and then click **OK** to create the prodrive.cfg configuration file and to proceed with your evaluation.

**Obtaining a Valid License**

ProDrive requires a valid license to operate the application. Typically, Harmonic emails you a license file upon receipt of your order. If you experience difficulties obtaining the license file, contact Harmonic Technical Support (refer to [Appendix B, Contacting the Technical Assistance Center](#)). Once you obtain the file, place it in the same directory as your copy of ProDrive. For example: C:\Program Files\Omneon\ProDrive. Ensure the license file ends in .lice and not .lic. For example: ProDrive_license.lice. When you install a ProDrive license, the software will operate fully.

To determine if your version is correctly licensed, launch ProDrive and select **Help > About** from the Menu bar. The **About** box displays information about each license installed, together with their expiration dates.
About the Media API DLL and ProDrive

A copy of the Media API DLL (ommedia.DLL) is required to enable the Save As and Flatten features available in the ProDrive application. This DLL is not packaged in the ProDrive executable. If you do not have a copy of this DLL, the following error message appears when you attempt to log on to the application.

![Warning](image)

Figure 2–11: No File Found

To obtain a copy of the DLL, compatible with the Spectrum software version running on your system, contact Harmonic Technical Support (refer to Appendix B, Contacting the Technical Assistance Center). Once you receive the file, save it to the location where ProDrive.exe is installed. The default location in Windows XP is C:\Program Files\Omneon\ProDrive. For Windows 7 it is C:\Program Files(x86)\Omneon\ProDrive.
Chapter 3
Configuring ProDrive

In this Chapter

- Starting ProDrive
- Configuring a Media Server
- Limiting Access to the ProDrive Configuration Screens
- Customizing the Appearance of Events
- Configuring RouteMaster Integration
- Configuring BXF Integration
- Assigning Roles to Players
- Disabling a Player for Use With ProDrive
- About Configuration and Log Files

Starting ProDrive

To start:
1. Click Start > Programs > Omneon > ProDrive.

The Overview window opens.

Figure 3–1: Overview Window

NOTE: A Not Connected message appears in the bottom right corner of the window if ProDrive has not yet been configured. Proceed to Configuring a Media Server for instruction on how to configure the application.
Configuring a Media Server

Ensure the following is completed before configuring a media server for control by ProDrive:

- All Players and media servers must have valid reference. VITC is mandatory if your are running either playout or scheduled ingest, AND you have selected VITC reference as the time synchronization source for that Player role. During a crash record, having VITC (or any reference) available is not a requirement but it is recommended.

- All Players to be used by ProDrive must:
  - Have “Last Frame Freeze” set to 0.

- “Clock Ref” VITC line values from within a media server configuration must be set correctly for your system.

- The “Time Zone” value from within a media server configuration must be set correctly for your system.

**NOTE:** Simultaneous control of Players using ProDrive and other controlling devices such as a DNF box is not recommended. A DNF box is not capable of controlling a ProDrive Playlist.

To configure the media server IP address:

1. From the ProDrive menu bar, click **Tools > Configuration**.

The ProDrive Configuration window opens to the **General** tab.
NOTE: Configuration window opens automatically if no file system/media director has been specified.

<table>
<thead>
<tr>
<th>MediaDirector IP (Control)</th>
<th>Specifies the current name, DNS name, or IP address of the Harmonic server hosts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File System Folders:</td>
<td>Shows the default folder where the source clips reside. This value defines the default path to which Clip Management will open. You cannot access areas of the file system that fall outside of the specified root folder. For example, if this is set to /fs0/clip.dir then you will only be able to browse to folders under /fs0/clip.dir, you will not be able to browse /fs0/xyz.</td>
</tr>
<tr>
<td>Root Folder</td>
<td></td>
</tr>
</tbody>
</table>
### Default Folder

Specifies the path used during the first time the clip list is browsed. This value is used by The Clip Management screen and the Playout - Add Clips window. The value defined in the Capture to Folder is the default browse path for Clip Prep, Scheduled Ingest, and VTR Ingest. This can be set per player in the player specific tab. For all of the above scenarios, the last browsed to location is remembered for future access until the application is restarted. Once restarted, the defaults will once again be used.

### Timecode Display

Specifies the timecode to display in ProDrive. The options are:

- **Timecode**—causes all time-related fields and readouts in the application to display the internal timecode of a clip. The top left time is “elapsed time” from SOM, shown as a “time count” rather than a timecode. The top right is remaining time (time count) until EOM. The center or main time is the real “Timecode”.

- **Frame Counts**—causes all time-related fields and readouts in the application to display frame counts. The top left and right time become frame counts to/from EOM/SOM. The center or main time becomes frame count from the beginning of the physical clip.

- **Time Counts**—causes all time-related fields and readouts in the application to display a relative time count in which the starting point of a clip is always zero. The top left time is “elapsed time” from SOM, shown as a “time count”. The top right is remaining time (time count) until EOM. The center or main time is the time count from the beginning of the physical clip (not the SOM).

- **Dropframe**—if enabled, controls the display of 29.97 or 59.94 timecodes when a Player is not involved, for instance in the display of clip durations in the media management screen. If a Player is involved (ie, when recording, or in a playout screen) then the drop-frame setting of the Player (from SystemManager) takes precedence. This should always be set to match that of the Player in SystemManager.

### Ingest Options

See step # 6.

2. Click the **Add** button to the right of the Control IP Addresses box and enter the current name, DNS name, or IP address of the media server host.

| **TIP:** | Harmonic recommends using the IP address of the media server instead of the DNS name. |
| **3.** | Click **OK**. |

To check a media server host’s current name, click the Configuration tab in the SystemManager application. The name appears beside the small media server icon.

| **NOTE:** | Your system can have multiple MediaDirectors but they must all use the same filesystem. ProDrive must be associated with a media server host before it can be linked to a Player on that host. |
If the connection is successful, new tabs are added to the ProDrive Configuration window for each Player configured on that media server.

**NOTE:** The number of Players you can control is limited by your ProDrive license. The maximum number of Players is six.

![Configuration Window](image)

Figure 3–3: Configuration Window

4. Replace the **Samba IP Address** with the IP address of your file system.

**NOTE:** Each ProDrive installation can talk to only one filesystem at a time.

5. Specify the **File System Root** folder, **Default Folder**, and **Timecode Display**, as required.

**NOTE:** The File System Root Folder is generally fs0 and is case sensitive. This value defines the default path to which Clip Management will open. You can find this value on the Disk Utilities screen in the SystemManager application.

**TIP:** Whenever you need to enter a folder name, use the "..." button to open a dialog to browse to available folders. This avoids problems with directory case-sensitivity.
6. Specify the **Ingest Options** including **Suffix Separator**, **Clip Name Pattern**, and **Default Record Duration**.

<table>
<thead>
<tr>
<th>Ingest Options</th>
<th>Shows the following ingest options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- <strong>Suffix Separator</strong>—When ProDrive creates new media clips, it may append a number to clip names to distinguish multiple attempts to create the clip. Use this option to separate a number appended by ProDrive from the parent clip name. For example, if you try to ingest MYCLIP several times with a suffix of &quot;:-&quot;, then files MYCLIP, MYCLIP-1, MYCLIP-2 will be created.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> For clip names which end in a number, a new media clip will get a name which increments the last number of the parent clip; the clips will not have suffix separators. For example, if you try to ingest SPORT1 several times, files SPORT2, SPORT3, SPORT 4 etc will be created, assuming that SPORT2, SPORT3, and SPORT4 do not already exist.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Clip Name Pattern</strong>—Use for crash record only. The default pattern is $P$-$D$-$T$-_1, where $P$ is the current Player name, $D$ is the current date (dd-mmm-yyyy), and $T$ is the current time (hhmmss). Edit this pattern, if required, using any combination of Unicode characters. Refer to <strong>About the Automatic Renaming of Sub Clips Using Clip Patterns</strong> for additional information.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default record duration</strong>—shows the default record duration for all crash record events across all channels in the format hh:mm:ss:ff.</td>
</tr>
</tbody>
</table>

7. Click **OK**.

**Limiting Access to the ProDrive Configuration Screens**

ProDrive Configuration screens are, by default, openly accessible and configurable by any user of the ProDrive application. However, password protection can be applied to the ProDrive Configuration screens using the Windows Registry Editor. Once a password is set, users who attempt to access the Configuration screen will be prompted to enter a password before gaining access.
To set a password:
1. Ensure you have installed ProDrive version 1.1 or later.
2. In Windows, click on Start > Run.
3. Enter regedit in the text field.
4. Click OK.

The Registry Editor window opens.

Figure 3–4: Registry Window

5. Navigate to:

- My Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Omneon > ProDrive > Config (for Windows XP)
- Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > ProDrive > Config (for Windows 7)

6. In the right hand panel, right click and select New > String Value.
7. Type Password and then press Enter.
8. Double click Password.

An Edit String dialog opens.
9. In the **Value data**: enter a password of your choice.
10. Click **OK**.
11. Close the Registry Editor.

**To verify or edit an existing password:**

1. Open a Registry Editor Window.
2. Navigate to:
   - **My Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Omneon > ProDrive > Config** (for Windows XP)
   - **Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > ProDrive > Config** (for Windows 7)
3. In the right hand panel, view the existing password in the data column as shown below.

**Figure 3–6: Registry Window Password**

Edit the password by double-clicking password and revising the text in the Value data field as shown below.
4. Click **OK** to save any changes.

**To check if a password has been set:**

1. Open a Registry Editor Window.

**Figure 3–7: Change Password**

2. Navigate to:
Customizing the Appearance of Events

ProDrive assigns default colors to event status, types, and durations so these parameters can be easily distinguished in the ProDrive interface. If desired, you can assign your own color preferences to these Events.

To customize:
1. From the ProDrive menu bar, click Tools > Configuration.
   - The ProDrive Configuration window opens.
2. Click the Appearance tab.
### Table 3–1: ProDrive Configuration—Appearance Tab

<table>
<thead>
<tr>
<th>Event Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current (VTR Ingest)</td>
<td>The clip which is currently being ingested from tape to server.</td>
</tr>
<tr>
<td>Cued (Playlist)</td>
<td>The clip or file specified is cued for playout.</td>
</tr>
<tr>
<td>Ready</td>
<td>The clip has been loaded onto the media server timeline.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The clip or file is hard-timed but has not yet reached its start time.</td>
</tr>
<tr>
<td>Playing</td>
<td>The clip or file specified is currently playing out</td>
</tr>
<tr>
<td>Invalid</td>
<td>The clip or file specified is invalid or missing.</td>
</tr>
<tr>
<td>Pending</td>
<td>The clip or file is scheduled to play, but is not yet playing and not yet pre-loaded for playing.</td>
</tr>
<tr>
<td>Disabled</td>
<td>The Event specified has been disabled for use.</td>
</tr>
<tr>
<td>Completed</td>
<td>The clip or file specified has successfully finished playing out or ingesting.</td>
</tr>
<tr>
<td>Completed – Error</td>
<td>The clip or file specified has finished playing with errors.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Events</td>
<td>The clip or file specified will be started manually.</td>
</tr>
<tr>
<td>Auto Events</td>
<td>The clip or file specified will start.</td>
</tr>
<tr>
<td>Hard-timed Events</td>
<td>The clip or file specified will start at the specified time.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event Duration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Truncated Events</td>
<td>The clip or file specified has been truncated by a following hard-timed event.</td>
</tr>
</tbody>
</table>
3. Choose the **Event Status**, **Event Types**, or **Event Duration** you want to change.

4. Click the **Paint** icon: ![Paint Icon]

5. Select the color you want to assign.

6. Click **OK**.

7. When you are done assigning colors to Events, click **OK**.

### Configuring RouteMaster Integration

ProDrive 1.3 and later can be integrated with the RouteMaster application to take advantage of its router control capabilities.

**To configure RouteMaster integration:**
1. Click **Tools > Configuration** to open the ProDrive Configuration dialog box.
2. Click the **RouteMaster Integration** tab, as shown in the following figure.
3. Configure as follows:

4. **RouteMaster Integration**: Select to enable RouteMaster integration.
   - **RouteMaster IP Address**: Enter the IP address of the client PC that is running RouteMaster.
   - **Monitor Switching**: When selected, you can use RouteMaster to route a selected player’s output to a separate monitor. The selected player is changed by clicking the different player tabs in ProDrive.
     - **Monitor Output**: Enter the number of the Router Output connected to your monitor.

**IMPORTANT**: In order to use the Monitor Switching feature for a player, make sure to configure the “Router Setup” options for that player when you enable it in the ProDrive Configuration dialog box. See *Enabling a Player For Scheduled Ingest*, *Enabling a Player for Clip Preparation*, or *Enabling a Player for Playout*.

5. Click **OK**.
Configuring BXF Integration

ProDrive 1.3, and later, can be integrated with a BXF traffic system to receive BXF messages.

**NOTE:** At this time, BXF support is qualified with the Myers ProTrack* system only.

To configure BXF integration:

1. Click **Tools > Configuration** to open the ProDrive Configuration dialog box.
2. Click the **BXF Integration** tab, as shown in the following figure.

3. Configure as follows:
   - **BXF Integration**: Select to enable BXF Integration.
   - **Incoming Port**: This is the port for your BXF traffic system. Leave the default setting unless instructed otherwise by Harmonic Technical Support.
   - **BXF Media Updates**: Select to enable the **Send Media Updates** button in the Clip Preparation window, which allows you to notify your BXF traffic system that a clip is ingested and ready for playout, or that a clip has been modified. See **Understanding the Clip Preparation Window**.
   - **SOAP Endpoint**: Enter the web address of the BXF service that will receive media updates.
   - **Clean Database**: Click to empty historical logs from the database. Note this does not remove any scheduled events.
4. Click OK.

Assigning Roles to Players

ProDrive can control Players that have been configured in the SystemManager application. Each Player can be configured in ProDrive to function in one of the following roles:

- **None**—Disables the Player for use by ProDrive.
- **Playout**—Enables the Player for automated clip playout. See *Playing Out Clips* for more information.
- **VTR Ingest**—Enables the Player for VTR Ingest operations from VTRs. See *Performing a VTR Ingest* for more information.
- **Scheduled Ingest**—Enables the Player for scheduling ingests at specified times and dates. See *Performing a Scheduled Ingest* for more information.
- **Clip Preparation**—Enables the Player for previewing and editing of media clips. See *Preparing Clips* for more information.

ProDrive is available in one to six channel versions. The six channel version enables any combination of in/out ports that the hardware supports.

Disabling a Player for Use With ProDrive

To disable:
1. From the ProDrive menu bar, click **Tools > Configuration**.
   
   The ProDrive Configuration window opens.
2. In the toolbar, click a **Player** tab.
3. Select the **None** option.
About Configuration and Log Files

Once you configure the ProDrive software, the application creates a configuration file (prodrive.cfg) and a directory for each configured Player/channel. This file, and all log files for the application, resides in the user’s Application Data Directory.

If ProDrive was installed by the user “Administrator” then the following path is created and used by the executable: C:\Documents and Settings\Administrator\Application Data\Omneon\ProDrive.

NOTE: Folder locations are specific to the operating system and language in use. In Windows Vista®, for example, the typical folder used is C:\Users\<username>\AppData\Roaming\Omneon\ProDrive.

Table 3–2: ProDrive Configuration—Player Tab

<table>
<thead>
<tr>
<th>Role</th>
<th>Selects the role assigned to the Player. Refer to Assigning Roles to Players.</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Disables the Player for use by ProDrive.</td>
</tr>
<tr>
<td>Name</td>
<td>(Optional) Assigns a name to the button that appears in the Overview Window, as well as the button that appears in the top row of buttons. The default name is the one configured using SystemManager.</td>
</tr>
<tr>
<td>Channel Logo</td>
<td>(Optional) Assigns a logo (in png. format) to the button that represents this Player. The logo appears in the Overview window as well as the top row of buttons. Click Load Logo to use a logo; click Clear Logo to remove it. Note that all images are resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, and .png.</td>
</tr>
</tbody>
</table>

4. Click **OK**.

About Configuration and Log Files

Once you configure the ProDrive software, the application creates a configuration file (prodrive.cfg) and a directory for each configured Player/channel. This file, and all log files for the application, resides in the user’s Application Data Directory.

If ProDrive was installed by the user “Administrator” then the following path is created and used by the executable: C:\Documents and Settings\Administrator\Application Data\Omneon\ProDrive.

NOTE: Folder locations are specific to the operating system and language in use. In Windows Vista®, for example, the typical folder used is C:\Users\<username>\AppData\Roaming\Omneon\ProDrive.
If a different user, such as “Joe” then logged on to the same PC and launched ProDrive, the version of ProDrive that opens will not be configured for any MediaDirectors or Players. This is normal behavior since the application was looking for a configuration file in C:\Documents and Settings\Joe\Application Data\Omneon\ProDrive

**TIP:** Since the configuration file is not shared, each user must configure their own system. Harmonic recommends you login to the PC as an administrator, install and configure the application, and then copy the prodrive.cfg file to each users Application Data\Omneon\Prodrive directory.
Chapter 4
Performing a VTR Ingest

In this Chapter
- Overview
- Enabling a Player for VTR Ingest
- Configuring a COM Port for VTR Control
- Understanding the VTR Ingest Window
- Understanding the VTR Ingest List
- Managing VTR Ingest Lists
- Managing Clips in VTR Ingest Lists
- Managing a VTR Ingest

Overview
VTR Ingest capabilities allow you to capture content from your tapes while simultaneously controlling the source VTR via serial protocol. In addition, you can create an ingest list based on the content of a tape, and then capture and digitize all marked sections from that tape. This feature captures content from multi-segment tapes, and also handles long-form content that spans multiple tapes. Ingest lists can also be created in external applications and imported into ProDrive.

Enabling a Player for VTR Ingest
Before enabling a Player for VTR Ingest, do the following:
- Using SystemManager, ensure the Player is configured for Play and Record, or Record.
- Connect a serial com port on the PC where ProDrive is installed to an RS-422 remote control port on a VTR. Refer to Cable Requirement for VTR Ingest for information about obtaining the recommended cable.
- Make sure the VTR and MediaPort have matching reference black.
- Connect the SDI out of the VTR to the SDI in on the MediaPort.

To enable:
1. From the ProDrive menu bar, click Tools > Configuration.
   The ProDrive Configuration window opens.
2. In the Configuration window, click the desired Player’s tab.
3. Select the VTR Ingest option.
Enabling a Player for VTR Ingest

Figure 4–1: ProDrive Configuration – Player Tab

Table 4–1: ProDrive Configuration—Player Tab

<table>
<thead>
<tr>
<th>Role</th>
<th>Enables the Player for VTR Ingest operations from video tape recorders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Optional) Assigns a name to a button that represents a Player in playout or ingest roles. The button appears in the Overview window. The default name is the one configured in SystemManager.</td>
</tr>
<tr>
<td>Channel Logo</td>
<td>(Optional) Assigns a logo to the button that represents this Player. The logo appears in the Overview window. Click <strong>Load Logo</strong> to use a logo; click <strong>Clear Logo</strong> to remove it. Note that all images are resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, and .png.</td>
</tr>
<tr>
<td>VTR Control Serial Port</td>
<td>Choose the serial port through which ProDrive will control this VTR.</td>
</tr>
<tr>
<td>Tape Preroll</td>
<td>Select the number of seconds for the tape to roll before the inpoint.</td>
</tr>
<tr>
<td>Eject Tape</td>
<td>This option is checked by default. You can de-select this option to configure the system to not eject the tape after the last ingest completes.</td>
</tr>
</tbody>
</table>
Configuring a COM Port for VTR Control

ProDrive can be configured to control a single VTR for either a specific Player, or for general use, not tied to a specific channel. Follow these steps to do either:

1. Connect the VTR’s remote control cable to a COM port on the PC.

   **NOTE:** This can be a serial COM port, or the USB connection if you have a USB to Serial dongle.

2. Enable the remote button on the VTR.

3. Determine if the VTR is going to be a general use VTR, or used for the specific purpose of VTR ingest, for example the Player’s Role is configured for VTR Ingest.

   **For general use (not tied to a specific channel):** Go to Tools > VTR Control and select the COM port connected to the VTR. A VTR control panel opens.

   **For a Specific Player:** Go to Tools > Configuration > Player Tab > VTR Control/Serial Port.

   **NOTE:** Multiple VTRs connected to multiple COM ports are supported; each can be assigned to a different Player, or for general use.

   **NOTE:** The Tools/VTR Control function cannot be used to control a VTR already assigned to a ProDrive VTR Ingest channel.

Understanding the VTR Ingest Window

The VTR Ingest window is arranged into different groups of controls and displays. From top to bottom, these are the Players area, Clip Status area, Transport controls, Jog/Shuttle dial, Cue to Timecode controls, Clip Trim controls, and a VTR Ingest List panel that contains clips for ingest. A Button bar is provided on the left side of the window.
Figure 4–2: VTR Ingest Window

Controls

- Shows the name of the Player and current status of the ingest process: Idle, Cueing to, or [I/N] Ingesting.
- Indicates the process is idle.
- Indicates a normal operating condition.
- Indicates a Warning condition that requires user intervention. For example, in a Playlist, an item may be cued but the Take button needs to be clicked. In a VTR Ingest, the Warning may be issued when you need to change reels.
### Understanding the VTR Ingest Window

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Indicates an Error condition that requires user intervention. For example, in a Playlist, the clip for the next event may be missing. In a VTR Ingest, the Warning may be issued because an ingest failed to occur, or the ingest was invalid.</td>
</tr>
<tr>
<td>01:33:13;22</td>
<td>Shows the current timecode location of the clip HH:MM:SS:FF (hours:minutes:seconds:frames) during playout. Also shows the transport status of the VTR in the upper right corner. If this timecode is displayed, then you have successful communication with the VTR via the serial port. <strong>NOTE:</strong> Note that this is VTR timecode and not server timecode.</td>
</tr>
<tr>
<td>⏪</td>
<td>(Rewind) Plays the VTR in reverse.</td>
</tr>
<tr>
<td>⏸</td>
<td>(Stop) Stops the playback of the VTR.</td>
</tr>
<tr>
<td>⏯</td>
<td>Plays (pauses) the VTR.</td>
</tr>
<tr>
<td>⏯</td>
<td>Plays the VTR.</td>
</tr>
<tr>
<td>⏦</td>
<td>(Fast Forward) Plays the VTR forward at 2x.</td>
</tr>
</tbody>
</table>
| | Enables manual control of tape by moving the Jog/Shuttle dial as follows:  
  - moving the dial to the left changes the clip’s current speed to the next faster reverse speed.  
  - moving the dial to the right changes the clip’s current speed to the next faster forward speed.  
  The following transport speeds are supported, as multiples of normal forward play: -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, -1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 16, 32.  
  - moving the dial to the left or the right by one click jogs forward or backward, one frame at time.  
  - clicking and holding the dial for a couple of seconds switches between jog and shuttle mode. |
### Understanding the VTR Ingest Window

**Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Ingest List</td>
<td>Clears the current VTR Ingest list from the VTR Ingest List panel.</td>
</tr>
<tr>
<td>Open Ingest List</td>
<td>Opens an existing VTR Ingest list in the VTR Ingest List panel.</td>
</tr>
<tr>
<td>Save Ingest List</td>
<td>Saves the current batch list using the default name batchlist.ale.</td>
</tr>
<tr>
<td>Save As...</td>
<td>Saves the current VTR Ingest list to a directory and name of your choice.</td>
</tr>
<tr>
<td>Run Ingest List</td>
<td>Runs the VTR Ingest list currently loaded in the VTR Ingest List panel.</td>
</tr>
<tr>
<td>Reset List</td>
<td>Resets the VTR Ingest list to the beginning.</td>
</tr>
<tr>
<td>Crash Record</td>
<td>Puts the MediaPort in record mode and begins recording whatever signal is currently going to the SDI IN of that port. The port used is the same as the port configured for this role; in this case, VTR ingest. Crash records can be configured to run for a specified duration, creating a clip on your media server, and clips can be scheduled for playout on another port while being recorded.</td>
</tr>
</tbody>
</table>

**Cues the VTR to the specified timecode.** Enter the timecode values in the fields provided, then press the **Cue** button.

**Modifies performance of Jog/Shuttle and JKL keys to use slower speeds for fine control.** Shuttle control now runs at max +/- 2x speed.

- **Mark [IN Point], Mark [OUT Point]** — These two buttons set the inpoint and outpoint of the material on the tape which you want ingested. Once ingested, the clip’s SOM and EOM are set to match these frames. Clicking a **Mark** button sets that point on the VTR’s current frame. Both the inpoint and outpoint are inclusive; the frames thus marked are the first and last frames to be shown during clip playback.

- **Cue [IN Point], Cue [OUT Point]** — These two buttons cue to the in point or outpoint of the VTR/tape.

- **Clear [IN Point], Clear [OUT Point]** — Clicking a **Clear** button clears the corresponding marked point.

- **Duration** — Shows the duration of the tape segment between the inpoint (SOM) and outpoint (EOM).
Menus

<table>
<thead>
<tr>
<th>File</th>
<th>Exit—closes ProDrive and exits the application.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools</td>
<td>Configuration—configures ProDrive.</td>
</tr>
<tr>
<td></td>
<td>VTR Control—opens a VTR transport control window for VTRs connected to the PC serial com port(s).</td>
</tr>
<tr>
<td></td>
<td>View Log—displays the event log at the bottom of the window.</td>
</tr>
<tr>
<td>Help</td>
<td>About—provides information about the ProDrive release.</td>
</tr>
</tbody>
</table>

Understanding the VTR Ingest List

A VTR Ingest list is based on the content of a tape and contains the following information:

- Heading
- Video format
- FPS
- Tape number
- Start time
- End time
- Duration
- Track number
- Name

VTR Ingest lists use the Avid Log Exchange (ALE) format. Lists can be created in ProDrive or in an external applications and imported into ProDrive. You can create them with a text editor and save them with a .ale extension.

The following illustration shows an example of a VTR Ingest list.

```
<table>
<thead>
<tr>
<th>Tape</th>
<th>Start Time</th>
<th>End Time</th>
<th>Duration</th>
<th>Track</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>4:01</td>
<td>01:17:03:12</td>
<td>01:17:17:20</td>
<td>00:00:14:08</td>
<td>00:10:00:00</td>
<td></td>
</tr>
<tr>
<td>1:01</td>
<td>01:17:03:21</td>
<td>01:17:14:44</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:02</td>
<td>01:17:03:31</td>
<td>01:17:14:41</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:03</td>
<td>01:17:04:31</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:04</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:05</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:06</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:07</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:08</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:09</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:10</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:11</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:12</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:13</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:14</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:15</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:16</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:17</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
<tr>
<td>1:18</td>
<td>01:17:04:32</td>
<td>01:17:14:40</td>
<td>00:00:11:23</td>
<td>00:00:16:06</td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 4–3: VTR Ingest List
Managing VTR Ingest Lists

This section provides the following procedures:

- Creating VTR Ingest Lists
- Opening VTR Ingest Lists
- Clearing VTR Ingest Lists

Creating VTR Ingest Lists

To create a VTR Ingest list:

1. From the ProDrive toolbar, click the Player configured for VTR Ingest.

2. Do the following:
   a. On the Transport controls, click **Play**.
      The tape begins to play.
   b. Using a monitor, watch the tape and determine the inpoint and outpoint for this clip.
   c. Using the **In Point** and **Out Point** controls, mark the inpoint and outpoint for this clip.

3. Repeat step 2 for each clip you want to add.

   **NOTE:** You can use the Transport controls, Jog/Shuttle dial, and Cue to Timecode tools to locate the time or frame you want to mark in the clip.

4. On the Transport controls, click **Stop**.
5. When you are done, click **Save Ingest List** using a name and directory of your choice. Retain the .ale file extension.

Opening VTR Ingest Lists

To open a VTR Ingest list:
1. From the ProDrive toolbar, click the Player configured for VTR Ingest.

![Image of VTR Ingest Player - Open](Figure 4–5: VTR Ingest Player – Open)

2. In the VTR Ingest window button bar, click **Open Ingest List**.
   The Open Ingest List File window opens.

![Image of Open Ingest List](Figure 4–6: Open Ingest List)

3. Select the VTR Ingest list you want.
4. Click **OK**.
   The VTR Ingest list is loaded in the VTR Ingest List panel.

**Clearing VTR Ingest Lists**

To clear a VTR Ingest list:
1. From the ProDrive toolbar, click the Player configured for VTR Ingest.
2. In the VTR Ingest window button bar, click New Ingest List. A confirmation dialog appears. Click Yes to clear the Ingest List.

Managing Clips in VTR Ingest Lists

This section provides the following procedures:

- Adding Clips to a VTR Ingest List
- Editing Clips in a VTR Ingest List
- Deleting Clips from a VTR Ingest List
- Cueing Clips in a VTR Ingest List

Adding Clips to a VTR Ingest List

To add clips to a VTR Ingest list:
1. From the ProDrive toolbar, click the Player configured for VTR Ingest.
2. Right-click the VTR Ingest List panel and select **New Clip**.

The Add Event window opens.
Managing Clips in VTR Ingest Lists

Figure 4–10: Add Event Window

3. In the **Clip Name** field, enter a name for the clip.
4. In the **Folder** field, browse to the folder where the clip will be saved.
5. In the **Reel** field, enter the reel number.
   
   Use this field if the clip is part of a VTR Ingest list that spans multiple reels.
6. In the **Capture section**, enter the **In Point** and **Out Point** for the clip.
   
   The duration is calculated for you.
7. Click **OK**.
   
   The clip is added to the VTR Ingest List panel.
8. Repeat steps 1 through 7 for each clip you want to add to the VTR Ingest list.
9. When you are done, click **Save Ingest List** using a name and directory of your choice. Retain the .ale file extension.

Editing Clips in a VTR Ingest List

To edit a clip in a VTR Ingest list:

1. From the ProDrive toolbar, click a Player configured for VTR Ingest.

Figure 4–11: VTR Ingest Player – Edit
2. Right-click the clip you want in the VTR Ingest List panel and select **Edit Clip**. The Edit Event window opens.

![Edit Event Window](image)

**Figure 4–12: Edit Event Window**

3. In the **Clip Name** field, enter a name for the clip.
4. In the **Folder** field, browse to the folder where the clip will be saved.
5. In the **Reel** field, enter the reel number if the clip is part of a VTR Ingest list that spans multiple reels.
6. In the **Capture section**, enter the **In Point** and **Out Point** for the clip.
   The duration is calculated for you.
7. Click **OK**.
8. When you are done, click **Save Ingest List** using a name and directory of your choice. Retain the .ale file extension.

**Deleting Clips from a VTR Ingest List**

**To delete a clip from a VTR Ingest list:**

1. From the ProDrive toolbar, click a Player configured for VTR Ingest.

![VTR Ingest Player - Delete](image)

**Figure 4–13: VTR Ingest Player – Delete**
Chapter 4 Performing a VTR Ingest

Managing a VTR Ingest

2. Right-click the clip you want in the VTR Ingest List panel and select **Delete Clip** or press Delete on your keyboard.

**NOTE:** No confirmation is required to delete a clip.

3. When you are done, click **Save Ingest List** using a name and directory of your choice. Retain the .ale file extension.

**Cueing Clips in a VTR Ingest List**

The Cue Clip function cues the VTR to the current time in the selected clip.

**To cue a clip in a VTR Ingest list:**

1. From the ProDrive toolbar, click the Player configured for VTR Ingest.

   ![Figure 4–14: VTR Ingest Player - Cue](image)

2. Right-click the clip you want in the VTR Ingest List panel and select **Cue Clip**.

**Managing a VTR Ingest**

This section explains how to perform the following procedures:

- **Running a VTR Ingest**
- **Skipping to the Next Clip**
- **Stopping a VTR Ingest**

**Running a VTR Ingest**

**To run a VTR Ingest:**

1. From the ProDrive toolbar, click a Player configured for VTR Ingest.
Chapter 4 Performing a VTR Ingest

Managing a VTR Ingest

2. Create or open a VTR Ingest list. The VTR Ingest list is loaded in the VTR Ingest List panel.

3. In the VTR Ingest window button bar, click Run Ingest List.

   ProDrive begins the ingest process.

4. If multiple reels are required, the current reel is ejected and you will be prompted to insert the next reel in a multi-reel ingest.

5. Insert the next tape and click OK.

6. To complete the VTR Ingest process, allow all clips to be ingested.
When the process is done, ProDrive will eject the tape in the VTR, and the status will return to Idle.

**Skipping to the Next Clip**

**To skip to the next clip in a VTR Ingest:**

1. From the VTR Ingest window, click **Skip**.
   - If the ingest of the current clip has not yet begun, the current event will be skipped and the remaining items in the list will be ingested.
   - If the the ingest of the current clip has already begun, the ingest will stop, the partial clip will be deleted from the server, and the remaining items will be ingested.

**Stopping a VTR Ingest**

**To stop a VTR Ingest:**

- From the VTR Ingest window, click **Abort**.

The VTR Ingest process stops and the VTR status changes to **Idle**.

**Rerunning a VTR Ingest**

**To rerun a VTR Ingest:**

1. From the VTR Ingest window, click **Reset List**.
   
   The list status clears, as if it had never run.

2. Click **Run Ingest**

   The ingest process begins. If the clip name is already present at the specified location on the server, it will not be reingested and the status will show invalid; the event will be skipped.

**NOTE:** To reingest material such as replacing a clip, go to **Clip Management** and delete the old clip first before rerunning the ingest.
Chapter 5
Performing a Scheduled Ingest

ProDrive’s schedule management features enables users to view, edit, and create new scheduled record items at any time of day, for any duration. At the specified time, your media server will switch to record mode and capture your desired content.

The following topics are covered in this chapter:

- Understanding the Scheduled Ingest Window
- Enabling a Player For Scheduled Ingest
- Managing Scheduled Ingest Lists
- Managing Scheduled Ingest Events

Understanding the Scheduled Ingest Window

The Scheduled Ingest window is arranged into different groups of controls and displays. From top to bottom, these are the Players Area and Clip Status Area. A Button bar is provided on the left side of the window. The Scheduled Ingest List panel is on the right.

![Figure 5–1: Scheduled Ingest Window](image)
### Controls

<table>
<thead>
<tr>
<th>Scheduled Ingest: XDCAMHD-50-10</th>
<th>Shows the name of the Player and current status of the ingest process: Idle, Cueing to, or [I/N] Ingesting.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Idle" /></td>
<td>Indicates the process is idle.</td>
</tr>
<tr>
<td><img src="image" alt="Normal" /></td>
<td>Indicates a normal operating condition.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Indicates a Warning condition that requires user intervention. For example, in a Playlist, an item may be cued but the Take button needs to be clicked. In a VTR Ingest, the Warning may be issued when you need to change reels.</td>
</tr>
<tr>
<td><img src="image" alt="Error" /></td>
<td>Indicates an Error condition that requires user intervention. For example, in a Playlist, the clip for the next event may be missing. In a VTR Ingest, the Warning may be issued because an ingest failed to occur, or the ingest was invalid.</td>
</tr>
</tbody>
</table>

### Buttons

<table>
<thead>
<tr>
<th><img src="image" alt="New Schedule" /></th>
<th>Clears the current scheduled ingest list from the Scheduled Ingest List panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open Schedule" /></td>
<td>Opens an existing scheduled ingest list in the Scheduled Ingest List panel.</td>
</tr>
<tr>
<td><img src="image" alt="Save Schedule" /></td>
<td>Saves the current scheduled ingest list to a directory and name of your choice.</td>
</tr>
<tr>
<td><img src="image" alt="Crash Record" /></td>
<td>Puts the MediaPort in record mode and begins recording whatever signal is currently going to the SDI IN of that port. The port used is the same as the port configured for this role; in this case, Scheduled ingest. Crash records can be configured to run for a specified duration, creating a clip on your media server.</td>
</tr>
</tbody>
</table>

### Menus
Enabling a Player For Scheduled Ingest

To enable a Player for scheduled ingest:
1. From the ProDrive menu bar, click **Tools > Configuration**. The ProDrive Configuration window opens.
2. In the Configuration window, click on the desired Player’s tab.
3. Select the **Scheduled Ingest** option.
## Enabling a Player For Scheduled Ingest

<table>
<thead>
<tr>
<th>Role</th>
<th>Scheduled Ingest</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables the Player for scheduled ingest at specified times and dates.</td>
</tr>
</tbody>
</table>

| Name | (Optional) Assigns a name to the button that appears in the Overview Window, as well as the button that appears in the top row of buttons. The default name is the one configured using SystemManager. |

| Channel Logo | (Optional) Assigns a logo to the button that represents this Player. The logo appears in the Overview window as well as the top row of buttons. Click **Load Logo** to use a logo; click **Clear Logo** to remove it. Note that all images are resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, and .png. |

| Router setup | These options are available when Monitor Switching is enabled on the RouteMaster Configuration tab (see Configuring RouteMaster Integration). These options specify the input and output numbers for RouteMaster-controlled routers. Configure as follows:  
- **Router Input**—select the Router Input number that’s connected to the MediaPort/ChannelPort output.  
- **Router Output**—the Router output number that’s connected to the MediaPort input (not relevant for playout role). |

| Default folder for Ingest Capture to folder | Specifies the folder where the ingested clips are captured. The default folder is defined in the general tab under Default folder for ingest. |

| Default folder for Ingest Append Date | Adds the current date to the end of the specified clip name. The date is in the following format:  
- YYMMDD, i.e. clipname_091001.  
By checking this option, Append Date is always enabled from within the Scheduled Ingest screen. You can uncheck this option when a record event is created/scheduled. |

| Timecode/Time of Day Time-of-day Source | Specifies the the time source used for issuing timed event commands such as playing or recording at a specific time of day.  
- **Local PC Time**—uses the local time on the client PC as the time reference.  
- **Player LTC**—uses the Linear timecode (LTC) of the Player as the time reference.  
- **MediaDirector Time**—uses the media server time as the time reference.  
- **VITC Reference**—uses SMPTE Vertical interval timecode (VITC) as the time reference. For frame accuracy, Harmonic recommends using VITC Reference for Playout and Scheduled Ingest roles. Both the media server and MediaPort should be supplied reference from the same VITC reference source. |
Managing Scheduled Ingest Lists

This section provides the following procedures:

- Assigning a Scheduled Ingest List for a Player
- Clearing Scheduled Ingest Lists
- Saving Scheduled Ingest Lists

Assigning a Scheduled Ingest List for a Player

To assign a scheduled ingest list to a Player:

1. From the ProDrive Player’s Area, click the Player configured for scheduled ingest.
2. In the Scheduled Ingest window button bar, click Open Schedule.

<table>
<thead>
<tr>
<th>Segment Clips</th>
<th>Specifies that the Segment Clip option for each scheduled ingest will be on by default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Duration</td>
<td>Specifies the default segment length in hh:mm:ss:ff.. The maximum number of segments allowed per record event is 48. For example, if you have a 24 hour record event and you want it segmented, then you should not use a segment duration of less than 00:30:00:00. If you do, then the number of segments above 48 will not be recorded. Similarly, if you have a 12 hour record event, the minimum segment duration would be 00:15:00:00.</td>
</tr>
<tr>
<td>Segment Duration: Tag with Number</td>
<td>Sequentially, beginning with 1, appends a number to the Clip Name for each segment that is created. i.e. ingest_1, ingest_2, ingest_3.</td>
</tr>
<tr>
<td>Segment Duration: Tag with Time</td>
<td>Appends the time of day the clip is created to the Clip Name for each segment that is created. i.e. ingest_221500, ingest_221700, ingest_221900.</td>
</tr>
</tbody>
</table>

4. Configure the parameters you want.
5. Click OK.
Managing Scheduled Ingest Lists

Chapter 5 Performing a Scheduled Ingest

Managing Scheduled Ingest Lists

Figure 5–3: Open Schedule

The Open window appears.

3. Select the scheduled ingest list you want.
4. Click OK.

The scheduled ingest list is loaded in the Scheduled Ingest List panel.

Clearing Scheduled Ingest Lists

To clear a scheduled ingest list:

1. From the ProDrive Player’s Area, click the Player for which you want to clear the Scheduled Ingest List.
Figure 5–5: Player Selection

2. In the Scheduled Ingest window button bar, click **New Schedule**.

The Scheduled Ingest List is cleared in the Scheduled Ingest List panel.

**Saving Scheduled Ingest Lists**

To save a scheduled ingest list:

1. From the ProDrive Player’s Area, click a Player configured for scheduled ingest.

Figure 5–6: Player for Scheduled Ingest

2. Edit the list, as required.

See *Editing Events in a Scheduled Ingest List* for more information.
3. In the Scheduled Ingest window button bar, click **Save Schedule**. Save the schedule using a name and directory of your choice.

**Managing Scheduled Ingest Events**

This section provides the following procedures:

- **Adding Events to a Scheduled Ingest List**
- **Editing Events in a Scheduled Ingest List**
- **Deleting Events in a Scheduled Ingest List**

**Adding Events to a Scheduled Ingest List**

To add an event to a Scheduled Ingest list:

1. From the ProDrive Player Area, click the Player configured for scheduled ingest.

   ![Figure 5–7: Adding Events](image)

   **Figure 5–7: Adding Events**

2. Right-click anywhere in the Scheduled Ingest List panel and select **New Event**. The Add Scheduled Event window opens.
3. Configure the parameters you want.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Enables the event for ingest.</td>
</tr>
<tr>
<td>Clip Name</td>
<td>Specifies the name of the clip being ingested.</td>
</tr>
<tr>
<td>Append Date</td>
<td>Appends the date (YMMMDAY) the clip is created to the Clip Name defined above i.e. ingest_090917, ingest_090919, ingest_090921.</td>
</tr>
<tr>
<td>Folder</td>
<td>Specifies the folder in which the clip will be ingested.</td>
</tr>
<tr>
<td>Description</td>
<td>Provides a description of the ingest. Note that this description is not saved as part of the clip’s metadata. It is solely used in the ProDrive’s GUI.</td>
</tr>
<tr>
<td>Timing: Once, on</td>
<td>Specifies the day and time of the ingest.</td>
</tr>
<tr>
<td>Timing: Every...</td>
<td>Specifies the days and time at which the clip will be ingested.</td>
</tr>
<tr>
<td>Timing: Start at</td>
<td>Specifies the start time in 24-hour format, HH:MM:SS:FF (hour:minutes:seconds:frames)</td>
</tr>
<tr>
<td>Timing: Duration</td>
<td>Specifies the duration of the clip being ingested in HH:MM:SS:FF (hours:minutes:seconds:frames) for the ingest to begin.</td>
</tr>
<tr>
<td>Segment Clip</td>
<td>Segments the clip according to the specified duration.</td>
</tr>
<tr>
<td></td>
<td>■ Tag with number—Sequentially, beginning with 1, appends a number to the Clip Name defined above for each segment that is created. i.e. ingest_1, ingest_2, ingest_3.</td>
</tr>
<tr>
<td></td>
<td>■ Tag with time—Appends the time of day the clip is created to the Clip Name defined above for each segment that is created. i.e. ingest_221500, ingest_221700, ingest_221900.</td>
</tr>
</tbody>
</table>
4. Click **OK**.
   The event is added to the Scheduled Ingest List panel.

**NOTE:** The schedule will reflect any currently active recording for the port that is configured for that instance of Scheduled Ingest.

5. Repeat steps 1 through 4 for each ingest event you want added to the Ingest schedule.
6. When you are done, click **Save Schedule** using a name and directory of your choice. Retain the .txt file extension.

**Editing Events in a Scheduled Ingest List**

**To edit an event in a scheduled ingest list:**

1. From the ProDrive Player Area, click the Player for which you need to edit the Scheduled Ingest List.

![Figure 5–9: Player Selection – Scheduled Ingest](image)

2. Right-click the desired event in the Scheduled Ingest List panel and select **Edit Event**.
   The Edit Scheduled Event window opens.
3. Configure the parameters you want.

   See Adding Events to a Scheduled Ingest List for more information.

4. Click OK.

Deleting Events in a Scheduled Ingest List

To delete an event in a scheduled ingest list:

1. From the ProDrive Player Area, click the Player configured for scheduled ingest.

   Figure 5–11: Player for Scheduled Ingest

   2. Right-click the desired event in the Scheduled Ingest List panel and click Delete Event.

   No confirmation is necessary.
Chapter 6
Preparing Clips

In this Chapter

- Overview
- Understanding the Clip Preparation Window
- Enabling a Player for Clip Preparation
- Managing Clips and the Clip Prep List

Overview

ProDrive provides clip preparation tools for trimming the in and out points of existing clips, creating new sub-clips from existing clips, and combining multiple clips into a single new clip (flattening), to ensure that the content stored on your media server is ready for transmission whenever you need it. Using ProDrive, you can load any available clip from your media server into any ProDrive configured Player and play, pause, rewind, fast forward, to review, edit, and update the Start of Media (SOM) and End of Media (EOM) of that clip.

You can jog and shuttle through the clip, find points of interest, mark new in and out points, and create new sub-clips based on this data or flatten individual clips into a new file.

Understanding the Clip Preparation Window

The Clip Preparation window is arranged into different groups of controls and displays. From top to bottom, these are the Players Area, Clip Status Area, the Transport Controls, Shuttle Controls, Looping Controls, Cue to Timecode Controls, and the Clip Trim Controls. A Button bar is provided on the left side of the window. A Clip Prep List panel appears on the right.

Figure 6–1: Clip Preparation Window

Clip Prep List Panel with Clips
## Controls

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Crash_0" /></td>
<td>Shows the name of the clip.</td>
</tr>
<tr>
<td><img src="image" alt="Gray" /></td>
<td>Indicates the process is idle.</td>
</tr>
<tr>
<td><img src="image" alt="Checkmark" /></td>
<td>Indicates a normal operating condition.</td>
</tr>
<tr>
<td><img src="image" alt="Exclamation" /></td>
<td>Indicates a Warning condition that requires intervention. For example, in a Playlist, an item may be cued but the Take button needs to be clicked. In a VTR Ingest, the Warning may be issued when you need to change reels.</td>
</tr>
<tr>
<td><img src="image" alt="Exclamation" /></td>
<td>Indicates an Error condition that requires user intervention. For example, in a Playlist, the clip for the next event may be missing. In a VTR Ingest, the Warning may be issued because an ingest failed to occur, or the ingest was invalid.</td>
</tr>
<tr>
<td><img src="image" alt="Playing" /></td>
<td>Shows the status of the clip: Stop, Pause, Forward, Rewind, Pause, or Playing.</td>
</tr>
<tr>
<td><img src="image" alt="Timecode" /></td>
<td>Shows duration elapsed, as represented by the timecode and progress bar. This will be displayed as Time Count or Frame Count, depending on the setting used in the General Configuration tab. If Frame Count is used, this will be displayed in frames, otherwise this is displayed as a Time counter.</td>
</tr>
<tr>
<td><img src="image" alt="Duration Remaining" /></td>
<td>Shows the duration remaining. This will be displayed as Time Count or Frame Count, depending on the setting used in the General Configuration tab. If Frame Count is used, this will be displayed in frames, otherwise this is displayed as a Time counter.</td>
</tr>
<tr>
<td><img src="image" alt="Current Position" /></td>
<td>Shows the current position of the clip in HH:MM:SS:FF (hours:minutes:seconds:frames). This will be displayed as Timecode, Time Count, or Frame Count depending on the setting used in the General Configuration tab.</td>
</tr>
<tr>
<td><img src="image" alt="Previous Clip" /></td>
<td>(Previous clip) Plays the previous clip. Note that Previous Clip/Page up typically moves to the head of the previous clip. If you are NOT at the head of the current clip however, this control will move you to the head of the current clip instead.</td>
</tr>
<tr>
<td><img src="image" alt="Rewind" /></td>
<td>(Rewind) Plays the clip at –8x.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>(Stop) Stops the playback or recording of a clip.</td>
</tr>
<tr>
<td><img src="image" alt="Play/Pause" /></td>
<td>Plays (pauses) the clip at 0x, presenting a still frame. If no clip is loaded, black is played.</td>
</tr>
<tr>
<td><strong>Understanding the Clip Preparation Window</strong></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Steps</strong></td>
<td></td>
</tr>
<tr>
<td>Plays the clip at 1x (normal play mode).</td>
<td></td>
</tr>
<tr>
<td>(Fast Forward) Plays the clip at 8x.</td>
<td></td>
</tr>
<tr>
<td>(Next clip) Plays the next clip. Note that Next Clip/Page down always moves you to the head of next clip - unless you are already at the last clip, in which case, it moves you to the tail of the last clip.</td>
<td></td>
</tr>
<tr>
<td>When on, limits speed to +/- 2x.</td>
<td></td>
</tr>
<tr>
<td>Controls the jog/shuttle dial as follows:</td>
<td></td>
</tr>
<tr>
<td>- moving the dial to the left changes the clip’s current speed to the next faster reverse speed.</td>
<td></td>
</tr>
<tr>
<td>- moving the dial to the right changes the clip’s current speed to the next faster forward speed.</td>
<td></td>
</tr>
<tr>
<td>The following transport speeds are supported, as multiples of normal forward play: -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, -1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 16, 32.</td>
<td></td>
</tr>
<tr>
<td>- moving the dial to the left or the right by one click jogs forward or backward, one frame at time.</td>
<td></td>
</tr>
<tr>
<td>Tracks and enables manual control of the shuttle process. Press and hold to switch between jog and shuttle modes, as for VTR ingest.</td>
<td></td>
</tr>
<tr>
<td>Specifies the following looping options:</td>
<td></td>
</tr>
<tr>
<td>- <strong>None</strong>—Disables looping and bounce.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Loop</strong>—Causes the clip list, which can be comprised of a single clip, or multiple clips loaded in the Clip Prep list area, to restart upon reaching its end. In this mode, the clip plays continuously until Stop is clicked. Inactive clips (not shown in red) can be selected and moved while the Player is in Loop mode. Note that the Player must be stopped before the Loop mode can be activated.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Bounce</strong>—Repeatedly plays a clip from its IN point and OUT point and then back again. In this mode, the clip reverses when it reaches its OUT point, playing back and forth. NOTE: Bounce mode works only with DV clips. It does not work with MPEG I-frame or Long GOP clips.</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE:</strong> Looping and Bounce are only applicable when the clip is being controlled through Clip Preparation.</td>
<td></td>
</tr>
<tr>
<td>Cues the clip to the specified timecode. Enter the timecode values in the fields provided.</td>
<td></td>
</tr>
</tbody>
</table>
Understanding the Clip Preparation Window

- **Mark [IN Point], Mark [OUT Point]**—These two buttons set the clip’s inpoint and outpoint — the starting and ending frames for clip playback. Clicking a Mark button sets that point on the clip’s current frame. Both the inpoint and outpoint are inclusive; the frames thus marked are the first and last frames to be shown during clip playback.

- **Cue [IN Point], Cue [OUT Point]**—These two buttons cue to the inpoint or outpoint of the clip.

- **Clear [IN Point], Clear [OUT Point]**—Clicking a Clear button clears the corresponding marked point.

- **Mark and Split** — This button allows you mark multiple In and Out points of a clip, splitting the clip into segments. The clip segments appear in the clip prep window, and are saved when you save the clip. To load the segments later, use the Load Segment Data button. See *Creating and Loading Clip Segments*.

- **Duration** — Shows the duration of the clip between the inpoint (SOM) and outpoint (EOM).

Note the following:

- When no inpoint is set, the default inpoint is the first frame of the clip and the corresponding Clear button is grayed-out and disabled.

- When no outpoint is set, the default outpoint is the last frame of the clip and the corresponding Clear button is grayed-out and disabled.
### Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Clip...</td>
<td>Loads a clip from the selected director to the Clip Prep List. You can now manage the clip with ProDrive using the Transport controls and perform clip editing procedures using the Looping, Cue to Timecode, and Clip Trim controls.</td>
</tr>
<tr>
<td>Add clip...</td>
<td>Adds a clip from the selected directory to the Clip Prep List panel.</td>
</tr>
<tr>
<td>Save Clip As...</td>
<td>Saves a new clip in the defined directory with the file name you specify. Clips <strong>must be I-Frame</strong> only and have the exact same attributes including: number and type of video tracks, number and type of audio tracks, format, and frame rate. LGOP clips are not distinguished from I-Frame.</td>
</tr>
<tr>
<td>Clear List</td>
<td>Clears the Clip Prep List panel.</td>
</tr>
<tr>
<td>Update Clip</td>
<td>Updates the selected clip with the changes you made.</td>
</tr>
<tr>
<td>Flatten...</td>
<td>Flattens the selected clips into a new clip with the file name you specify. Clips to be flattened together <strong>must be I-Frame</strong> only and have the exact same attributes including: number and type of video tracks, number and type of audio tracks, format, and frame rate. LGOP clips are not distinguished from I-Frame but will not flatten correctly. <strong>NOTE:</strong> Save As and Flatten are very similar. Flatten performs a Save As, then loads the newly created clip onto the timeline, replacing the existing timeline contents.</td>
</tr>
<tr>
<td>Crash Record</td>
<td>Allows you to begin an ingest using the currently selected Player. Crash records will run for the specified duration, creating a clip on your media server, and clips can be scheduled for playout on another port while being recorded.</td>
</tr>
<tr>
<td>Load Segment Data</td>
<td>Loads all the segments of a clip, which has been split using the Mark &amp; Split feature. See <em>Creating and Loading Clip Segments</em>.</td>
</tr>
<tr>
<td>Send BXF Update</td>
<td>Click to notify the BXF traffic system that a clip is ingested and ready for playout. You may also use this button if you have modified a clip and need to notify the traffic system of the change. This feature is enabled from the BXF Integration tab (see <em>Configuring BXF Integration</em>).</td>
</tr>
</tbody>
</table>
Menus

<table>
<thead>
<tr>
<th>File</th>
<th>Exit—closes ProDrive and exits the application.</th>
</tr>
</thead>
</table>
| Clip Preparation | Load Clip—loads a clip from the selected directory to the Clip Prep List.  
Add Clip—adds a clip from the selected directory to the Clip Prep List panel.  
Save As—saves a new clip in the defined directory with the file name you specify. The default name presented for sub clips depends on the name of the parent clip. If the parent clip has a date/time at the end, then the default name is the parent name with an updated date/time. If the parent clip has a sequence number, then the next free number in sequence is used. If the parent clip has neither, then a sequence number is added using the suffix separator configured as part of the ingest options in the Configuration General tab.  
NOTE: The date/time appended to the end of a clip name is the time at which the Save As dialog box was opened. Close the dialog box and reopen the box to ensure the current date and time is appended to the clip name.  
Update—updates the selected clip or clips with the changes you made.  
Load Latest Recording—loads the most recent Crash Record clips from the current session known by ProDrive. VTR, scheduled ingest clips, or clips ingested from another session, or via a different application will not be loaded. |
| Tools | Configuration—configures ProDrive.  
VTR Control—opens a VTR transport control window for VTRs connected to the PC serial com port(s).  
View Log—displays the event log at the bottom of the window. |
| Help | About—provides information about the installed ProDrive release. |

Enabling a Player for Clip Preparation

To get started:
1. From the ProDrive menu bar, click **Tools > Configuration**. The ProDrive Configuration window opens.
2. Select the tab for the desired Player.
3. Select the **Clip Preparation** option.
Figure 6–2: Clip Preparation Window

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Preparation</td>
<td>Enables the Player for the manual previewing, preparation, and editing of media clips.</td>
</tr>
<tr>
<td>Name</td>
<td>(Optional) Assigns a name to the button that appears in the Overview Window, as well as the button that appears in the top row of buttons. The default name is the one configured using SystemManager.</td>
</tr>
<tr>
<td>Channel Logo</td>
<td>(Optional) Assigns a logo to the button that represents this Player. The logo appears in the Overview window as well as the top row of buttons. Click Load Logo to use a logo; click Clear Logo to remove it. Note that all images are resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, and .png.</td>
</tr>
</tbody>
</table>
| Router Setup       | These options are available when Monitor Switching is enabled on the RouteMaster Configuration tab (see Configuring RouteMaster Integration). These options specify the input and output numbers for RouteMaster-controlled routers. Configure as follows:  
  - Router Input—select the Router Input number that is connected to the MediaPort/ChannelPort output.  
  - Router Output—select the Router output number that is connected to the MediaPort input (not relevant for playout role). |
| Default Folder for ingest | Specifies the folder where the ingested clips are captured when a Crash Record is performed, or when new content is created from either flattening or creating new sub-clips. |

4. Configure the parameters you want.
5. Click OK.
Managing Clips and the Clip Prep List

This section describes the following tasks:

- About Opening Clips
- Adding Clips to the Clip Prep List
- Updating Clips
- Loading Clips
- Creating New Clips
- Flattening Clips
- Recording Clips (Crash Record)
- Ejecting Clips
- Clearing Clips
- Creating and Loading Clip Segments

About Opening Clips

Right clicking on a clip allows you to view the clip “Open” option. When you click “Open”, the clip opens with the application assigned for that file extension in Windows. For example, if you have QuickTime installed, “.mov” clips will open in QuickTime Viewer. VLC Media Player (http://www.videolan.org/vlc) can open .MXF files with embedded essence. If “Open” is greyed out, no application has been assigned to open the file extension of the particular clip.

Adding Clips to the Clip Prep List

To add a clip:

1. From the ProDrive Player Area, select the Player you have configured for Clip Preparation.
2. From the ProDrive menu bar, click **Clip Preparation > Add Clip**.

   The Clip Management window opens.

   ![ProDrive Browser: 10.5.132.27 PDA/TECA](Figure 6–3: Clip Management Window)

3. Select the clip you want to add.

   **NOTE:** You can select multiple clips using the Ctrl or Shift key.
4. Click **OK**.
   The selected clips appear in the Clip Preparation window.
5. Repeat **Step 2** through **Step 4** for each clip you want to add.

**TIP:** You can reorder clips in the Clip Preparation List panel by dragging and dropping them to a new location in the list.

### Updating Clips

Updating a clip involves changing its inpoint, outpoint, or both and then saving the updates/changes.

**To update a clip:**

1. From the ProDrive Player Area, select a Player you have configured for Clip Preparation.
2. From the Clip Preparation List panel, select the clip you want to update.
3. Using the **Clip Trim Controls**, mark the new **IN Point** and **OUT Point**.
4. In the Clip Preparation window button bar, click **Update Clip**.

A window opens with details of the updates.

![Figure 6–4: Information – Update Clip](image)

### Loading Clips

**To load a clip:**

1. From the ProDrive Player Area, select a Player you have configured for Clip Preparation.
2. In the Clip Preparation window button bar, click **Load Clip**.

The Clip Management window opens.
Chapter 6 Preparing Clips

Managing Clips and the Clip Prep List

Figure 6–5: Clip Management Window

3. Select the clip you want.
4. Click **OK**.

The clip appears in the Clip Preparation window and is loaded in the Player. You can now manage the clip with ProDrive using the Transport controls and perform clip editing procedures using the Cue to Timecode, and Clip Trim controls.

Creating New Clips

To create a new clip from an existing clip:
1. From the ProDrive Player Area, select the Player you have configured for Clip Preparation.
2. From the Clip Preparation List panel, select the clip you want to duplicate.
3. In the Clip Preparation window button bar, click **Save As**.

   The Clip Management window opens.

4. In the **File Name** field, enter the new name for the new clip.
5. Click **OK**.

Now you can edit the duplicate clip and make changes to the media without affecting the original clip.

Flattening Clips

Flattening clips involves merging multiple clips in the order in which they appear in the Clip Preparation window into a single clip.

To flatten clips into one clip:
1. From the ProDrive Player Area, select a Player you have configured for Clip Preparation.
2. In the Clip Preparation window button bar, click **Load** or **Add Clip**.

The Clip Management window opens.
Chapter 6 Preparing Clips

Managing Clips and the Clip Prep List

Figure 6–6: Clip Management Window

3. Select the clips you want to flatten.
4. Click **OK**.
   
The clips appear in the Clip Preparation window.

5. (Optional) Using the **Clip Trim Controls**, mark the new **IN Point** and **OUT Point** for each clip.
6. In the Clip Prep window button bar, click **Flatten**.
   
The Clip List window opens.

7. In the **File Name** field, enter the name for the flattened clips.
8. Click **OK**.
   
The flattened clip replaces the previous clips in the Clip Prep list panel.

**NOTE:** Flattening of clips only works frame accurately for I-Frame content. Clips to be flattened should be of the same format and wrapper type.

Recording Clips (Crash Record)

A Crash Record allows you to record a clip without having to name the clip or set up its recording duration. This type of recording is beneficial when a quick recording is required.

**To crash record a clip:**
1. From the ProDrive Player Area, select a Player you have configured for Clip Preparation.
2. In the Clip Preparation window button bar, click **Crash Record**.
   
The Crash Record window opens.

Figure 6–7: Crash Record Window
3. (Optional) Specify a new **Clip Name** for the clip.

   **NOTE:** If no name is specified, the system will auto assign a name. The system will assign a name based on the default clip name pattern as specified in the **Configuration > General Tab > Ingest Options**.

4. (Optional) Specify a new **Destination Folder** for the clip.

   **NOTE:** The default path, as defined in the Configuration window, will appear in gray.

5. (Optional) Specify the **Duration** for the clip to run.

   **NOTE:** The system will assign a duration based on the Default clip duration as specified in the **Configuration > General Tab > Ingest Options**.

6. To start a crash record, do the following:
   
   a. Click **Record**.
      
      Content that is currently being fed to the ingest port is recorded and created on the media server.

      **NOTE:** While the clip is being recorded on the ingest port, you can schedule other clips for playout on a playout port.

   b. To cancel and discard the crash record, click **Cancel**.
   c. To stop and save the crash record, click **Stop**.

   **NOTE:** While the crash record dialog is open, it is not possible to access other areas of ProDrive. To access other areas of ProDrive click on the X in the upper right corner of the Crash Record dialog window. This closes the window without stopping the record. The record will continue in the background until the specified duration has been reached.

   **NOTE:** Clicking on **Crash Record** from within the Clip Prep window displays the current status of any ingest that port is doing.

7. When the process is done, click **OK**.

   **NOTE:** While the crash record is in progress, you can adjust the duration if required. Enter a new duration and the record duration will update.

---

**Ejecting Clips**

**To eject a clip:**

1. From the ProDrive toolbar, select the Player you have configured for Clip Preparation.
2. From the Clip Prep List panel, right-click the clip you want to remove from the list and select **Eject Clip** from the menu.

**Clearing Clips**

**To clear all clips from the Clip Preparation List panel:**

1. From the ProDrive toolbar, select the Player you have configured for Clip Preparation.
2. In the Clip Preparation window button bar, click **Clear List**.

All clips in the Clip Preparation List panel are cleared.
Creating and Loading Clip Segments

With ProDrive 1.3 and later, you can use the Mark & Split button to split a clip into smaller segments, which can be saved in the clip data and loaded instead of loading the entire clip.

To create clip segments:
1. Load the clip to be segmented onto the timeline.
2. Find and mark the first in point.
3. If this is the only segment, find and mark the out point, and then save the clip. If you wish to create further segments, click Mark & Split. This marks the out point of the first segment, and then re-attaches the remainder of the clip as a separate segment, which appears as a clip on the timeline (see the following figure).

4. Repeat the previous two steps on the newly attached clip segment until complete.
5. Save the clip. The clip segment data will be saved.

When you wish to load the clip segments, click Load Segment Data and select the clip.
In this Chapter

- Overview
- Enabling a Player for Playout
- Understanding the Playout Window
- Understanding the Playout List Text File
- Managing Playlists
- Managing Playout Events
- Playing Clips

Overview

ProDrive provides comprehensive content playout features in the same user interface. Individual clips (or even sections of clips) can be loaded onto a port and either played out immediately or scheduled for playout at a specific time.

You can also create playlists containing multiple clips from your Harmonic media server. ProDrive supports complex transmission rules such as entire list loops, dynamically handling changes to the list’s contents. New clips arriving on the server can immediately be inserted into an active list at any desired point.

ProDrive can also import playlists from PlayTool, making it easy to integrate into existing workflows or other parts of your business.

Full logging of transmission output is provided, making it easy to compare schedules and as-run content – ensuring that what went to air matches what was intended.

Enabling a Player for Playout

To enable a Player for playing out clips:
1. From the ProDrive menu bar, click Tools > Configuration.

   The ProDrive Configuration window opens.

2. From the ProDrive toolbar, click a Player tab.

3. Select the Playout option.
Enabling a Player for Playout

Figure 7–1: Configuration Window – Player Tab

<table>
<thead>
<tr>
<th>Role</th>
<th>Enables the Player for automated clip playout.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Optional) Assigns a name to a button that represents a Player in playout or ingest roles. The button appears in the Overview window. The default name is the one configured in SystemManager.</td>
</tr>
<tr>
<td>Channel Logo</td>
<td>(Optional) Assigns a logo to the button that represents this Player. The logo appears in the Overview window. Click Load Logo to use a logo; click Clear Logo to remove it. Note that all images are resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, and .png.</td>
</tr>
</tbody>
</table>
Router setup

These options are available when Monitor Switching is enabled on the RouteMaster Configuration tab (see Configuring RouteMaster Integration). These options specify the input and output numbers for RouteMaster-controlled routers. Configure as follows:

- **Router Input**—select the Router Input number that’s connected to the MediaPort/ChannelPort output.
- **Router Output**—the Router output number that’s connected to the MediaPort input (not relevant for playout role).

Timecode/Time of Day

**Time-of-day Source**

Specifies the time source used for issuing timed event commands such as playing or recording at a specific time of day.

- **Local PC Time**—uses the local time on the client PC as the time reference.
- **Player LTC**—uses the Linear timecode (LTC) of the Player as the time reference.
- **MediaDirector Time**—uses the media server time as the time reference.
- **VITC Reference**—uses SMPTE Vertical interval timecode (VITC) as the time reference. For frame accuracy, Harmonic recommends using VITC Reference for Playout and Scheduled Ingest roles. Both the media server and MediaPort should be supplied reference from the same VITC reference source.

List Options

**Detached Clips to keep**—the number of completed items kept in view in the Playlist. If this is set to 5, the Playlist will show up to the last 5 completed or “Detached” clips.

**Clips to Preload**—the number of items loaded on the Player’s timeline and or in cue, including the currently playing clip. If this is set to 5 the playlist will show one item Playing, and 4 Ready. Refer to About Adding Placeholder Events to Playlists for important information.

GPI Triggers

Use to define triggers for:
- Take
- Hold
- Recue
- Drop

You cannot reuse a port within a channel, but you can share ports across channels.

### Understanding the Playout Window

The Playout window is arranged into different groups of controls and displays. From top to bottom, these are the Clip Status Area, Timecode, Playout Controls. A button bar is provided on the left side of the window. The Playlist panel is on the right.

| Default Event Properties | Use to insert or add events to a playlist. This will be the default event type. The options are:  
| | - Auto-Follow  
| | - Hard-Timed  
| | - Manual  
| As–Run Logs | Use to define the location where you want to save the As-Run logs. If traffic ID exists, it will be saved to As-Run logs. See Understanding the Playout List Text File. |

4. Configure the parameters you want.

5. Click OK.

**About Adding Placeholder Events to Playlists**

If a “placeholder” for a clip that is not present yet is put in a Playlist, the list will fail to start and return to idle state. This may occur in the following situations:

- There are several sequential placeholders all with a duration of 00:00:00:00 and no clip is defined.
- There are several sequential missing clips all with a duration of 00:00:00:00 but the clip is defined.
- Several events are dropped in order to hit a particular Hard-Timed event

To reduce the possibility of running into these issues, Harmonic recommends that you set the Clips to Preload value to a large number such as 10.

**Understanding the Playout Window**

The Playout window is arranged into different groups of controls and displays. From top to bottom, these are the Clip Status Area, Timecode, Playout Controls. A button bar is provided on the left side of the window. The Playlist panel is on the right.

**Controls**

![Figure 7–2: Playout Window](image-url)
### Understanding the Playout Window

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows the name of the clip.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates the clip playout process is idle.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates a normal operating condition.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates a Warning condition that requires user intervention. For example, in a Playlist, an item may be cued but the Take button needs to be clicked. In a VTR Ingest, the Warning may be issued when you need to change reels.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Indicates an Error condition that requires user intervention. For example, in a Playlist, the clip for the next event may be missing. In a VTR Ingest, the Warning may be issued because an ingest failed to occur, or the ingest was invalid.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows the status of the clip: Stopped, Paused, Forward, Rewind,Paused, or Playing.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows duration elapsed, as represented by the timecode and progress bar. This will be displayed as <strong>Time Count</strong> or <strong>Frame Count</strong>, depending on the setting used in the General Configuration tab. If <strong>Frame Count</strong> is used, this will be displayed in frames, otherwise this is displayed as a Time counter.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows the duration remaining. This will be displayed as <strong>Time Count</strong> or <strong>Frame Count</strong>, depending on the setting used in the General Configuration tab. If <strong>Frame Count</strong> is used, this will be displayed in frames, otherwise this is displayed as a Time counter.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Shows the current position of the clip in HH:MM:SS:FF (hours:minutes:seconds:frames). This will be displayed as <strong>Timecode</strong>, <strong>Time Count</strong>, or <strong>Frame Count</strong> depending on the setting used in the General Configuration tab.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Starts the selected clip cued for playout.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Activates the currently loaded list. The first item in the list Cues.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Loops the playlist so that once the last event in the playlist plays, the first event starts playing again. If Loop is enabled then the List options (<strong>Detached Clips to Keep</strong>, <strong>Clips to Preload</strong>) are ignored.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Takes the next clip cued for playout and plays it out.</td>
</tr>
</tbody>
</table>
Understanding the Playout Window

Chapter 7 Playing Out Clips

Playlist Column Layout

You can change and customize the playlist column layout.

Change Column Order

- a. Left-click on column header.
- b. Drag and drop the column to the new location.

Show and Hide Columns

- a. Right-click on the column header that you want to show or hide.
- b. Select the Visible Columns option from the menu.
- c. Choose Reset to go back to the factory default settings.

Column changes are automatically saved and applied to all Playout channels.

An Event List contains the following information:

| Checkbox | Shows if the event is Enabled for playout: Checked - event is enabled Not checked - event is not enabled. The entire line will also be grayed out and the Status will shows Disabled. |
| Description | Descriptive information for event added by user. This is not tied to clip metadata. |
| Clip Name | Name of clip to be played for this event |
| Start | hh:mm:ss:ff when event starts (time of day) "If this is a Hard-timed event with a date specified, the date will appear to the right of the Start time mm/dd/yyyy |
| Stop | hh:mm:ss:ff when event stops |
| Duration | hh:mm:ss:ff for event |
| Type | Control Type defining how this event will start (Manual, Hard, Auto) |

Drop Next | Drops the next clip cued for playout. |
Hold Next | Holds the next clip cued for playout and waits for your action. |
Recue | Recues the current clip back to the beginning of that clip. |
Chapter 7 Playing Out Clips

Understanding the Playout Window

The following illustration shows an example of a playlist with clips.

<table>
<thead>
<tr>
<th>Description</th>
<th>Clip Name</th>
<th>Start</th>
<th>Stop</th>
<th>Duration</th>
<th>Type</th>
<th>Status</th>
<th>Traffic ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC_window</td>
<td>burn_1.mov</td>
<td>10:16:09:12</td>
<td>10:16:10:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>12297</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_2.mov</td>
<td>10:16:10:12</td>
<td>10:16:11:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>1341</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_3.mov</td>
<td>10:16:11:12</td>
<td>10:16:12:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>77095</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_4.mov</td>
<td>10:16:12:12</td>
<td>10:16:13:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>44970</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_5.mov</td>
<td>10:16:13:12</td>
<td>10:16:14:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>123150</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_6.mov</td>
<td>10:16:14:12</td>
<td>10:16:15:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>2245079</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_7.mov</td>
<td>10:16:15:12</td>
<td>10:16:16:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>79998780</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_8.mov</td>
<td>10:16:16:12</td>
<td>10:16:17:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>8.09d=ucion=</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_9.mov</td>
<td>10:16:17:12</td>
<td>10:16:18:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>475785785689</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_10.mov</td>
<td>10:16:18:12</td>
<td>10:16:19:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>8616879</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_11.mov</td>
<td>10:16:19:12</td>
<td>10:16:20:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>1111</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_12.mov</td>
<td>10:16:20:12</td>
<td>10:16:21:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>1121</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_13.mov</td>
<td>10:16:21:12</td>
<td>10:16:22:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>555</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_14.mov</td>
<td>10:16:22:12</td>
<td>10:16:23:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>7777</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_15.mov</td>
<td>10:16:23:12</td>
<td>10:16:24:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>45678</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_16.mov</td>
<td>10:16:24:12</td>
<td>10:16:25:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>8070543</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_17.mov</td>
<td>10:16:25:12</td>
<td>10:16:26:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>876543</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_18.mov</td>
<td>10:16:26:12</td>
<td>10:16:27:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>79829079w695e</td>
</tr>
<tr>
<td>TC_window</td>
<td>burn_19.mov</td>
<td>10:16:27:12</td>
<td>10:16:28:12</td>
<td>00:00:00:00</td>
<td>Auto</td>
<td>Manual</td>
<td>686e297670</td>
</tr>
</tbody>
</table>

### Status

- **Shows state of Event/Clip, possible states are:**
  - "Ready" - Event is scheduled for playback and the Clip is on the player's timeline but not yet cued.
  - "Cued" - Event is scheduled for playback, clip is loaded into the Player and is cued to the specified point.
  - "Playing" - Clip is currently playing.
  - "Pending" - Event is scheduled for playback but the Clip is not yet on the player's timeline.
  - "Detached" - Event is complete.
  - "Missing" - Event is scheduled but clip is missing. This event will be skipped if no corrective action is taken.
  - "Disabled" - Event is scheduled but not enabled for playout. This event will be skipped.

### Buttons

- **New List**
  - Clears the Playlist panel, enabling you to load a new playout list.
- **Add Clips...**
  - Add one or more clips to the Playlist.
- **Open List...**
  - Opens a playout list in the Playlist panel.
- **Save List**
  - Saves the current playout list using the name and directory of your choice.
- **Append List...**
  - Appends the selected playout list to the current list in the Playlist panel.
- **Reload List**
  - Reloads the current Playlist.
Understanding the Playout List Text File

Playlists can be created in ProDrive, or in an external application and imported into ProDrive. You can create them with a text editor, using tabs to separate the fields, and then save them with a .txt extension.

A Playlist contains the following information:

<table>
<thead>
<tr>
<th>Clip</th>
<th>Clipname with path.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>hh:mm:ss:ff when event starts (time of day).</td>
</tr>
<tr>
<td>Stop</td>
<td>hh:mm:ss:ff when event stops.</td>
</tr>
<tr>
<td>Duration</td>
<td>hh:mm:ss:ff for event, if left blank, event uses clip duration.</td>
</tr>
<tr>
<td>TrafficID</td>
<td>This is where the traffic sequence number should be placed.</td>
</tr>
</tbody>
</table>
Managing Playlists

The following illustration shows an example of a playout list.

<table>
<thead>
<tr>
<th>Clip</th>
<th>Clipname with path.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>yyyy-mm-dd when event is to run.</td>
</tr>
<tr>
<td>Type</td>
<td>Trigger Type for event (Manual, Hard, Auto).</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive information for event added by user. This is not tied to clip metadata.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates if event should play or not (0 - enabled, 1 - disabled).</td>
</tr>
<tr>
<td>In point</td>
<td>hh:mm:ss:ff, of clip’s timecode for first frame, if left blank, event uses clip default In point.</td>
</tr>
</tbody>
</table>

The following illustration shows an example of a playout list.

- From the ProDrive toolbar, click a Player configured for playout.
- In the Playout window button bar, click Open List.

NOTE: When manually creating a playlist and running with drop frame, be sure to account for drop frame in the start time and duration columns. Use 00:00:00:00 instead of 00:00:00:00.

Managing Playlists

This section explains how to manage playlists and contains the following topics:

- Opening Playlists
- Appending Playlists
- Saving Playlists
- Clearing Playlists
- About Status Updates to the Playlist

Opening Playlists

To open a playlist:
1. From the ProDrive toolbar, click a Player configured for playout.
2. In the Playout window button bar, click **Open List**.

   The Open List window opens.
3. Select your list and then click **Open**.

Appending Playlists

To append a playlist:
1. From the ProDrive toolbar, click a Player configured for playout.
2. In the Playout window button bar, click **AppendList**.
   The Append List window opens.
3. Select your list and then click **Append**.
   The list is appended to the current one in the Playlist panel.

**Saving Playlists**

**To save the current playlist:**
1. From the ProDrive toolbar, click a Player configured for playout.
2. Edit the playlist, as required.
   Go to *Editing Playout Events* for information.
3. In the Playout window button bar, click **Save List**.
   The Save As dialog window opens.
4. Specify a name and location for the list
5. Click **Save**.
   The list is saved using a name and directory of your choice.

**Clearing Playlists**

**To clear a playlist:**
1. From the ProDrive toolbar, click a Player configured for playout.
2. In the Playout window button bar, click **New List**.
   The current list is removed from the Playlist panel and you can now open a new playlist.

**About Status Updates to the Playlist**

The system checks for missing clips, updates, and changes to duration and In/Out points and applies the following rules:

- If a clip is missing, the **Status** changes to **Missing**, in red.
- If a clip exists but is recording, the duration reflected in the event list will be equal to the current known duration.
- If a clip had been missing but now exists, the status will change to either Pending or Ready, depending on if that clip is outside or inside the Cue window (Clips to Preload).
- To ensure that you can view the active event in the playout window, configure the **Clips to Keep** value in the Player configuration to a number that will fit within the screen size that you use.

Any time the ProDrive application is opened, and the system is configured for playout, the system will try to “Join” the Player’s state. Thus, if you close the ProDrive application and there are Events on a Player’s timeline that are being played, the next time you open the ProDrive application, ProDrive will try to figure out where in the Playlist you are, then join/start that list.

- When a clip goes from **Pending** to **Ready**, the system does another check on that clip to get the latest information.
- If you wish to edit a clip, open the Edit window and click **Ok**. The system will do a check and get the latest information. A clip is considered edited even if you only just open the Edit window.
Managing Playout Events

This section explains how to manage playout event. It covers the following topics:

- Creating Playout Events
- Editing Playout Events
- Copying and Pasting Playout Events
- Cutting Playout Events
- Deleting Playout Events
- Selecting All Playout Events

Creating Playout Events

To create:
1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click anywhere in the Playlist panel and select New Event.

The Add Playout Event window opens.

![Add Playout Event Window](image)

**Figure 7–5: Add Playout Event Window**

<table>
<thead>
<tr>
<th>Enabled</th>
<th>Enables the Event for playout.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Provides a description of the Event.</td>
</tr>
<tr>
<td>Clip Name</td>
<td>Selects the Event you want from the default directory.</td>
</tr>
</tbody>
</table>

**Timing: Clip Type**

- **Auto-Follow**—Enables the Event to play out after the preceding Event finishes.
- **Hard-Timed**—Enables the Event to playout according to the scheduled start date and time.
- **Manual**—Enables the Event to playout only when you initiate a Take command. This can be accomplished using the Take button, setting a GPI trigger, or using the keyboard keys by clicking Ctrl + T. Manual events take precedence over Hard-Timed events.
3. Configure the parameters you want.
4. Click OK.

The new event is added to the Clip Playout list.

### Editing Playout Events

**To edit a playout event:**
1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click the event you want in the Playlist panel and select **Edit Event**.
   
   The Edit Playout List window opens.

   ![Edit Playout List Window](image)

   **Figure 7–6: Edit Playout List Window**

3. Configure the parameters you want.
4. Click OK.

**NOTE:** There is a 5 second lockout on events. This means you cannot initiate a Drop Next or otherwise edit the Next event if the current event is within 5 seconds of completing.

### Black can flicker on output:

Black can flicker momentarily on the output when the event following a Cued Held event is edited.
1. Start a playlist.
2. Take the first event.
3. While the first event is playing, click **Hold Next**. Event #2 is now Held.
4. Wait for the first event to complete. You will see a freeze of the first frame of the clip for event #2, the held event.

5. Edit event #3 by doing a Drop Next, Disabling or Enabling, or editing the event to use a different clip.

When any of the edits in step 5 are done, output goes black momentarily while the timeline changes are made.

**Copying and Pasting Playout Events**

To copy and paste playout events:

1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click the event(s) you want in the Playlist panel and select **Copy**.
3. Right-click anywhere in the Playlist panel, and select **Paste**.

The Event(s) are copied and pasted to the Playlist panel.

**Cutting Playout Events**

To remove an event from a Playlist so you can paste it elsewhere, cut the event.

To cut a playout event:

1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click the Event you want in the Playlist panel and select **Cut**.

**Deleting Playout Events**

To permanently remove an event from a Playlist, delete the Event.

To delete a playout event:

1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click the event you want in the Playlist panel and select **Delete Event**.

   A confirmation window opens.

3. Click **Yes**.

**Selecting All Playout Events**

To select:

1. From the ProDrive toolbar, click a Player configured for playout.
2. Right-click anywhere in the Playlist panel and select **Select All**.

All Events in the Playlist panel are now selected.

**Playing Clips**

To play one or more clips:

1. From the ProDrive toolbar, click a Player configured for playout.
2. Do one of the following:
   - In the Playout window button bar, click **Open List**.
     Load the list you want to play.
   - In the Playlist panel, right-click anywhere in the panel and select **New Event**.
Create the new Events you want to play.

3. To start playout, click **Start**.

4. Depending on how your event or playlist is configured, do one or more of the following:
   
   - If the event is Auto-follow, click **Take** to start the first event.
   - To deactivate the list and keep currently loaded clips from playing out, click **Stop**.
   - To manually trigger the next cued Event to play, click **Take**.
   - To drop the next clip cued for playout, click **Drop Next**.
   - To hold the next clip cued for playout and wait for your next action, clip **Hold Next**.
   - To recue the current clip back to the beginning, click **Recue**. Press **TAKE** to start the clip playing.
In this Chapter

- Overview
- Viewing Clips
- Managing Clips
- Adding Custom Metadata to Clip User Data
- Managing Clip Folders

Overview

The clip management features in ProDrive help you to manage the content stored in your Harmonic media server. With a full explorer view of the server’s contents, you can rename, move, copy and delete clips, all from your desktop. Even with complex reference or self-contained clips, a consolidated view makes your content manageable and accessible. Folder structures within the media server can also be created and organized with ProDrive.

Understanding the Clip Management Window

The Clip Management window displays clips for use by ProDrive. The default directory is specified during system configuration.

![Figure 8–1: CLip Management Window](image)

The window contains a scrollable, multi-column list of clips in the file system. The list is arranged in alphabetical order and shows all clips in the current directory. You can resize the columns by clicking and dragging the boundary between the column headers. Click any of the columns to sort the clips based on what you clicked.
Understanding the Clip Management Window

You can also filter the list of clips based on search criteria. In the Filter box, enter your search criteria to only show those clips containing the string in the name.

The default sort order when listing clips through a cliplist is newest to oldest (not alphabetical). This applies to:

- **Clip Management**
- **Clip Prep - Load Clip**
- **Clip Prep - Add Clip**
- **Playout - Add Clips**

## Menus

<table>
<thead>
<tr>
<th>File</th>
<th>Exit—Quits ProDrive.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Delete—Deletes the selected clip.</td>
</tr>
<tr>
<td></td>
<td>Rename—Renames the selected clip.</td>
</tr>
<tr>
<td></td>
<td>Properties—Displays the clip’s properties.</td>
</tr>
<tr>
<td></td>
<td>Select All—Selects all clips in the list.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Simple—Shows the default clip list.</td>
</tr>
<tr>
<td></td>
<td>Complex—Allows you to independently modify essense and clip files.</td>
</tr>
<tr>
<td></td>
<td>Refresh—Refreshes the list.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Configuration—Configures ProDrive.</td>
</tr>
<tr>
<td></td>
<td>VTR Control—Selects the COM port through which ProDrive communicates with the VTR.</td>
</tr>
<tr>
<td></td>
<td>View Log—Displays the event log at the bottom of the window.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>About—Provides information about the ProDrive release.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Shows the name of the clip, along with the file extension.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>Shows the total clip length (regardless of stored in-points and out-points).</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>Shows the aspect ratio of the clip.</td>
</tr>
<tr>
<td><strong>Framerate</strong></td>
<td>Shows the frame rate of the clip.</td>
</tr>
<tr>
<td><strong>Last Modified</strong></td>
<td>Shows the date and time the clip was created or last modified.</td>
</tr>
<tr>
<td><strong>FileType</strong></td>
<td>Shows the video file type.</td>
</tr>
<tr>
<td><strong>Tracks</strong></td>
<td>Shows the number of video and separate audio channels that have been recorded.</td>
</tr>
</tbody>
</table>
Viewing Clips

This section provides the following topics:

- Filtering Clips
- Viewing Clips in a Folder
- Viewing Clip Properties

Filtering Clips

To filter clips based on their name:
1. From the ProDrive toolbar, click Clip Management.

   The Clip Management window opens.
2. In the Filter field, enter the search criteria you want.

   ProDrive filters the table based on your search criteria.

Viewing Clips in a Folder

To view a description of a clip:
1. From the ProDrive toolbar, click Clip Management.

   The Clip Management window opens.
2. Hover the pointer over the clip you want.

   A description of the clip appears in a pop-up window.

Viewing Clip Properties

To view the properties of a clip:
1. From the ProDrive toolbar, click Clip Management.

   The Clip Management window opens.
2. Right-click the clip you want.
3. Select Properties from the pop-up menu.

Figure 8–2: Clip Properties Window
Managing Clips

This section provides the following topics:

- Selecting Clips
- Sorting Clips
- Renaming Clips
- Copying Clips
- Moving Clips
- Deleting Clips
- Changing to Complex View

Selecting Clips

To select one or more clips:

1. From the ProDrive toolbar, click Clip Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Shows the clip name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Shows the clip file type, along with the frame rate. For example, Quicktime Reference 29.97 fps or MXF Embedded 29.97 fps.</td>
</tr>
<tr>
<td>Size</td>
<td>Shows the size of the clip in megabytes.</td>
</tr>
<tr>
<td>Duration</td>
<td>Shows the total clip length (regardless of stored in and out-points) in HH:MM:SS:FF (hours:minutes:seconds:frames).</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Shows the date and time the clip was last modified.</td>
</tr>
<tr>
<td>Created</td>
<td>Shows the date and time the clip was created.</td>
</tr>
<tr>
<td>In Point (SOM)</td>
<td>Shows the in point time code.</td>
</tr>
<tr>
<td>Out Point (EOM)</td>
<td>Shows the out point time code.</td>
</tr>
<tr>
<td>First Frame</td>
<td>Shows the first frame of the media in HH:MM:SS:FF (hours:minutes:seconds:frames).</td>
</tr>
<tr>
<td>Last Frame</td>
<td>Shows the last frame of the media in HH:MM:SS:FF (hours:minutes:seconds:frames).</td>
</tr>
<tr>
<td>Protected</td>
<td>Indicates if the clip cannot be edited.</td>
</tr>
<tr>
<td>Playable</td>
<td>Indicates the clip is ready to play.</td>
</tr>
<tr>
<td>Record in progress</td>
<td>Indicates the clip is being recorded.</td>
</tr>
<tr>
<td>Property</td>
<td>Lists the tracks and user data associated with the clip.</td>
</tr>
<tr>
<td>Value</td>
<td>Lists all metadata associated with the clip such as Type, Title, Sample Ratio, Aspect Ratio, Channels, Sample Rate, BitRate, Bits per unit, Format, and Media File.</td>
</tr>
</tbody>
</table>
The Clip Management window opens.

2. Do one or more of the following:
   - Use the Arrow keys to move the highlight, or click the mouse on the clip you want.
   - Hold down Shift and click to select a continuous range.
   - Hold down Ctrl and click to select a discontinuous range.

### Sorting Clips

**To sort clips by one or more criteria:**

1. From the ProDrive toolbar, click **Clip Management**.
   - The Clip Management window opens.
2. Click the table column header you want to use to sort.
   - The table is sorted in ascending or descending alphabetical, numerical, or chronological order, depending on the selected column.

### Renaming Clips

**To rename a clip:**

1. From the ProDrive toolbar, click **Clip Management**.
   - The Clip Management window opens.
2. Right-click the clip you want to rename and select **Rename** from the pop-up menu.

3. In the **Rename file** pop-up window, enter the new file name.
4. Click **OK**.

### Copying Clips

**To copy a clip:**

1. From the ProDrive toolbar, click **Clip Management**.
   - The Clip Management window opens.
2. Ensure the display is in **Simple** view.
3. Right-click the clip you want.
4. Select **Duplicate** from the pop-up menu.
5. In the **Duplicate file** pop-up window, enter the name of the duplicate file.

**TIP:** To change to **Simple** view, click **View > Simple**.
6. Click OK.
ProDrive starts to duplicate the clip. The status of the “copy” operation is displayed in the status bar at the lower left corner of the window.

### Moving Clips

**To move a clip from one folder to another:**
1. From the ProDrive toolbar, click **Clip Management**.

   The Clip Management window opens.
2. Ensure the display is in **Simple** view.

   **TIP:** To change to Simple view, click **View > Simple**.
3. Select the clip you want.
4. Drag the clip to the Folders panel on the left and drop the clip on the sub-folder you want to contain it.

### Deleting Clips

**To delete a clip:**
1. From the ProDrive toolbar, click **Clip Management**.

   The Clip Management window opens.
2. Right-click the clip you want to delete.

   **TIP:** To select multiple clips, hold down the CTRL key while right-clicking on each clip you want to delete.
3. Select **Delete** from the pop-up menu.

   A confirmation window opens.
4. Click OK.

   **NOTE:** If a clip’s “Protection Bit” has been set by an external application (such as an automation system), the system will be unable to delete the clip.

### Changing to Complex View

**To change the clip management display to complex view:**
1. From the ProDrive toolbar, click **Clip Management**.

   The Clip Management window opens.
2. From the Menu bar, select **View > Complex**. Click **Yes** in the Confirmation pop-up window.
Adding Custom Metadata to Clip User Data

Starting with release 1.1, ProDrive allows you to add custom metadata to the user data of a clip. The metadata is then permanently stored in the clip and can be viewed by any application accessing the clip. The first step is to create an XML file where the custom metadata is defined. The XML file then provides additional fields for user input during Crash Recording and the saving of clips.

To create an XML file:
1. Close the ProDrive application.
2. Open a text file named “metadata” and save as “metadata.xml” to the location where ProDrive.exe is installed. The default location is C:\Program Files\Omneon\ProDrive.
3. Open “metadata.xml” and enter text following the format in this sample:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<metadata>
    <item name="TYPE" default="" prompt="Enter the content type, i.e. News, Sports, CA, etc" displayname="TYPE" maxlenlength="20"
    />
    <item name="TITLE" default="" prompt="Enter the title here" displayname="TITLE"
    maxlenlength="20"
    />
</metadata>
```

Note the following:
Adding Custom Metadata to Clip User Data

- **Item name**: The key name in the user metadata. Valid characters are US ASCII only. For example: `<item name="TYPE">

- **default**: The pre-filled value which appears in the text box for Crash Record or Save-As/Flatten. Full unicode is supported. For example: `default="clip">

- **prompt**: The instructions which appear in the text box for Crash Record or Save-As/Flatten if no other data is present, and the text box is not in focus. Full unicode is supported. For example: `prompt="Enter the content type, i.e. News, Sports, CA, etc">

- **displayname**: The name of the metadata field that the user will see. It appears to the left of the text box. Full unicode is supported. For example: `Displayname="TITLE">

- **maxlength**: The maximum length value which defines the numbers of characters the user can enter in the UI. The Default is 100. For example: `maxlength="20">

To view or edit the custom metadata of a clip:

1. Launch the ProDrive application.

You can view custom metadata for a clip at any of the following locations:

**Crash Record**

a. Select a Player you have configured for Clip Preparation.

b. In the **Clip Preparation** window button bar, click **Crash Record**.

The Crash Record dialog opens.

![Figure 8–6: Crash Record Window](image)

The Crash Record window above shows the custom data added to the sample file in **To create an XML file:**

**Save As**

a. Select a clip to save.

b. The **Save Clips** window opens.

![Figure 8–7: Save Clips Window](image)
The **Save Clips** window above shows the custom data added to the sample file in *To create an XML file:*

**Edit Metadata**

a. Select a Player you have configured for Clip Preparation.

b. In the **Clip Preparation** window right click the desired clip and select **Edit Metadata**.

The **Edit Metadata** dialog opens.

![Figure 8–8: Edit Metadata Dialog](image)

**NOTE:**

Metadata can also be viewed in the tooltips on the Media Management and Clip Prep/playout screens.

c. Edit the text fields as required

**NOTE:** When editing the .mov clip's metadata of an active ingest, you must wait until the clip ingest is complete.

---

**Managing Clip Folders**

This section provides the following topics:

- **Exploring Folders**
- **Creating Folders**
- **Renaming Folders**
- **Refreshing Folders**
- **Deleting Folders**

**Exploring Folders**

**To explore:**

1. From the ProDrive toolbar, click **Clip Management**.

   The Clip Management window opens.

2. From the **Folders** panel, right-click the root folder.

3. Click **Explore Folder** from the pop-up menu. The contents of the folder display in a Windows Explorer window.

**Creating Folders**

**To create a new folder:**

1. From the ProDrive toolbar, click **Clip Management**.

   The Clip Management window opens.
2. From the **Folders** panel, right-click the folder you want to contain the new folder.
3. Click **New Folder** from the pop-up menu.

![New Folder Window](image)

**Figure 8–9: New Folder Window**

4. In the **Add New Folder** field, enter a name for the new folder.
5. Click **OK**.

**Renaming Folders**

To rename a folder:
1. From the ProDrive toolbar, click **Clip Management**.
   The Clip Management window opens.
2. From the **Folders** panel, click ⇓ to expand the folders.
3. Right-click the folder you want.
4. Click **Rename Folder** from the pop-up menu.

![Rename Folder Window](image)

**Figure 8–10: Rename Folder Window**

5. In the **Rename folder** pop-up window, enter the new folder name and click **OK**.

**Refreshing Folders**

The Refresh Folders option refreshes the display of the "folder tree", rather than the list of files within a folder. To refresh, press F5 or View/Refresh from the Clip Management screen to update the folder tree and to refresh the clips list.

**Deleting Folders**

To delete a folder:
1. From the ProDrive toolbar, click **Clip Management**.
   The Clip Management window opens.
2. From the **Folders** panel, click ⇓ to expand the folders.
3. Right-click the folder you want.
4. Click **Delete Folder** from the pop-up menu.
   A confirmation window opens.
5. Click **OK**.
To prevent deleting clips:
1. In Windows, click on Start > Run.
2. Enter regedit in the text field.
3. Click OK.
   The Registry Editor window opens.
4. Navigate to:
   
   **My Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Omneon > ProDrive > Config** (for Windows XP)
   
   **Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > ProDrive > Config** (for Windows 7)
5. In the right hand panel, right click and select New > DWORD.
6. Add PreventDeletes as a DWORD value to the registry and then press Enter.
7. Double click DWORD.
   An Edit DWORD dialog opens.
8. In the Value data: type in 0 to allow deletes. Or, type in 1 to prevent deletes.
9. Click OK.
10. Close the Registry Editor.
Appendix A
Reference Information

In this Appendix

- Clip Preparation Keyboard Commands
- VTR Keyboard Commands
- List Control Keyboard Commands
- About the As-Run Log Header List
- About Authentication for MediaDirector 2202 Systems Working with ProDrive
- About Fault Handling in ProDrive
- About the Automatic Renaming of Sub Clips Using Clip Patterns

Clip Preparation Keyboard Commands

Use the following commands when doing clip preparation.

<table>
<thead>
<tr>
<th>Transport Controls</th>
<th>Key Press and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Pause</td>
<td>k (lower case K or caps lock + K)</td>
</tr>
<tr>
<td>Pause/Play Toggle</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop</td>
<td>Shift + spacebar</td>
</tr>
<tr>
<td>Reverse (Play Reverse)</td>
<td>j (lower case J)</td>
</tr>
<tr>
<td>Reverse faster (Play Reverse faster)</td>
<td>Press j (lower case) repeatedly (1x, 2x, 4x, 8x, 16x, 32x)</td>
</tr>
<tr>
<td>Step Back 1 frame</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Forward (Play Forward)</td>
<td>l (lower case L)</td>
</tr>
<tr>
<td>Forward faster (Play Forward faster)</td>
<td>Press l (lower case) repeatedly (1x, 2x, 4x, 8x, 16x, 32x)</td>
</tr>
<tr>
<td>Step Forward 1 frame</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Go to In Point</td>
<td>Shift I (upper case I)</td>
</tr>
<tr>
<td>Go to Out Point</td>
<td>Shift O (upper case O)</td>
</tr>
<tr>
<td>Go to Previous Clip</td>
<td>Page up</td>
</tr>
<tr>
<td>Go to Next Clip</td>
<td>Page down</td>
</tr>
<tr>
<td>Close Crash Record Dialog</td>
<td>Shift+click Record (button) once recording has started.</td>
</tr>
</tbody>
</table>
VTR Keyboard Commands

Use the following commands when doing VTR Ingest.

<table>
<thead>
<tr>
<th>Edit Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark In</td>
</tr>
<tr>
<td>Mark Out</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport Controls</th>
<th>Key Press and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Pause</td>
<td>k (lower case K)</td>
</tr>
<tr>
<td>Pause/Play Toggle</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Reverse (Play Reverse)</td>
<td>j (lower case J)</td>
</tr>
</tbody>
</table>

- **Step 1 frame back**
  - Left arrow
  - Left arrow = 1 frame
  - Shifted left arrow = 5 frames
  - Ctrl left arrow = 1 second
  - Shift+ Ctrl left arrow = 1 minute

  - Note that some VTRs cannot be accurately “jogged in this way”; some VTRs may jog less than a frame, some more.

- **Step 5 frames back**
  - Shift + left arrow
  - Tape reverses 5 frames.

- **Reverse 1 sec. back**
  - Ctrl + left arrow
  - Tape reverses 1 second.

- **Reverse 1 min. back**
  - Shift + Ctrl + left arrow
  - Tape reverses 1 minute.

- **Forward (Play Forward)**
  - l (lower case L)

- **Forward faster (Play Forward faster)**
  - Press l (lower case) repeatedly (1x, 1.9x, 3.2x)
List Control Keyboard Commands

Use the following commands to manipulate clip lists.

<table>
<thead>
<tr>
<th>Step Forward 1 frame</th>
<th>Key Press and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right arrow</td>
<td></td>
</tr>
<tr>
<td>Right arrow = 1 frame</td>
<td></td>
</tr>
<tr>
<td>Shifted right arrow</td>
<td></td>
</tr>
<tr>
<td>Shifted right arrow = 5 frames</td>
<td></td>
</tr>
<tr>
<td>Ctrl right arrow</td>
<td></td>
</tr>
<tr>
<td>Ctrl right arrow = 1 second</td>
<td></td>
</tr>
<tr>
<td>Shift+ Ctrl right arrow</td>
<td></td>
</tr>
<tr>
<td>Shift+ Ctrl right arrow = 1 minute</td>
<td></td>
</tr>
</tbody>
</table>

Note that some VTRs cannot be accurately “jogged in this way”; some VTRs may jog less than a frame, some more.

<table>
<thead>
<tr>
<th>Go to In Point</th>
<th>Shift I (upper case I)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Out Point</td>
<td>Shift O (upper case O)</td>
</tr>
</tbody>
</table>

**Edit Controls**

<table>
<thead>
<tr>
<th>Mark In</th>
<th>i (lower case I)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Out</td>
<td>o (lower case O)</td>
</tr>
</tbody>
</table>

**About ProDrive.exe Error Messages and Logs**

In ProDrive, Error Logs can be manually or generated.

**Generated Error Messages and Logs**

ProDrive generates a standard error message, shown below, if it encounters an issue which it does not know how to handle.

Figure 8–11: ProDrive Error Message
This message does not necessarily mean the application will not continue to operate correctly. When this message appears, click “Save bug report” and provide the requested details. Once saved, a text file is created which contains general details about the local PC hardware, configuration of the ProDrive system, error details, process, modules, call stacks that can be used to help determine the cause of the unexpected behavior. This file can then be sent to Technical Support, if requested.

Once the file is created, click “Continue” to close the dialog and return to the ProDrive application. If you continue to experience this error message, click “Restart ProDrive”.

**Generating a Manual Error Message and Log**

If you experience an issue with your ProDrive system that does not result in the auto-generated message mentioned in *Generated Error Messages and Logs*, you can manually generate an error message and save details of the system at the time of the behavior.

**To generate an error message:**

1. From the ProDrive toolbar click **Help > About**. Version and licensing information appears in a dialog.
2. Press Shift*.
   
   A ProDrive.exe error message to appear.
3. Choose one of the following options:
   - **Save bug report**: Enter the requested details.
   - **Send bug report**: Generates an issue report and sends it to support@omneon.com.
   - **Save bug report**: Saves the details of the bug report as a text file to a location you specify. You can enter contact information such as name, email, phone number, and facility name as well as notes about when the issue occurred.
   - **Show bug report**: Shows the information in the text file.

**About the As-Run Log Header List**

The As-run log header list is the header list for Playout As-run logs. As-run logs reside in the c:\Documents and Settings\User\Application Data\Omneon\ProDrive\Channel Name, where user is the login used to access the PC and install ProDrive, as well as the user who is currently logged in.

The As-Run file name is:

```
asrun-date-time.txt
```

where date is the date when the schedule ran and time is the time when the schedule began.

The location of the As-Run log is defined in the Player configuration screen. See *As-Run Logs*.

<table>
<thead>
<tr>
<th>Event Number</th>
<th>Item order in the playlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>YYYYMMDD when playlist started playing</td>
</tr>
<tr>
<td>On air Time</td>
<td>HH:MM:SS:FF when playlist started playing</td>
</tr>
<tr>
<td>Channel Name</td>
<td>Name of channel from ProDrive (corresponds to the player configured in this Role)</td>
</tr>
</tbody>
</table>
About Authentication for MediaDirector 2202 Systems Working with ProDrive

MediaDirectors support a variety of Access Control Settings, selected from the Access Control Screen in the SystemManager application. In general, Access Control Settings for MediaDirector 2202 can be configured in the same manner as you would with any other MediaDirector, with one exception:

- If you set the Authentication Type to LDAP and Guest Allowed to No, take these additional steps in the exact order:
  - Mount the file system on the PC which is running ProDrive, using the CIFS user name and password.
  - Configure ProDrive to communicate with the MediaDirector 2202.

About Fault Handling in ProDrive

ProDrive continually sends commands to Players and monitors the return status. If a Player stops responding, ProDrive will report “No Comms” in the Players status for that Channel. Buttons that actively affect the Player, such as transport controls in Clip Prep and Start List in the Playout screen, are disabled.
When switching Player tabs in the Overview or Clip Management screen, an error message may appear if a connection cannot be made to the Player. This does not affect playout or ingest, but may impact operations using the GUI. If you switch to the Player channel and continue to see an error message, switch away from the channel and then back to it to restore the connection. If this fails, close and reopen ProDrive to reestablish communication.

Frequently Asked Questions

What happens if the Player and/or the media server needs rebooting?

- Due to a Spectrum Player API limitation, communication will need to be reestablished if the network is disabled, a cable is removed, or a Player is deactivated/reactivated through SystemManager.
- If a playlist is active, playout will run in the absence of communication up to the end of the Players’ timeline. If communication is re-established before the timeline finishes, ProDrive will continue seamlessly. If the timeline has finished, playout will stop, and you will need to manually restart ProDrive.
- If a Scheduled Ingest is active, ingests in progress run without communication. If communication is missing when an ingest is due to start, it will not start but will begin shortly after communication is restored.
- If a VTR Ingest is active the VTR Ingest "Skip/Abort/Retry" messages appears.
- Flatten/Save as operations are reliant on the Media API and as such could fail if there is no communication to the media server or Player. Player control buttons such as transport controls are disabled if there is no communication to the Player.
- For Clip Management operations, Windows error messages are used for most cases. With "background" operations such as copies, four retries are made and errors are shown in the ProDrive log file.

What happens if the PC on which ProDrive is running loses network communication to the Director?

Refer to What happens if the Player and/or the media server needs rebooting?.

What happens if the media server loses power when upgrading a Spectrum system or a similar situation? Do I need to reboot the media server and the MediaPorts after upgrading the firmware?

Yes, restart ProDrive once the media server has completed rebooting.

What happens when a MediaPort loses power or a media server loses communication with a MediaPort while upgrading a Spectrum system? Do I need to reboot the media server and MediaPorts after upgrading the firmware?

ProDrive has no knowledge of communications between a MediaPort and a media server. It does not report on such problems.

What happens if the media server loses communication with the Player if its configuration has changed. Do I need to deactivate a Player to change its configuration?

Deactivating/reactivating a Player is similar to what happens if either a Player or a media server needs rebooting, except all clips loaded on the timeline are lost. For ingest, ProDrive restarts the ingest. For playout, the playout list stops and needs to be restarted.
About the Automatic Renaming of Sub Clips Using Clip Patterns

The Clip Name Pattern option on the ProDrive Configuration screen allows you to specify how new crash record clips are named. Clip Patterns can contain the following special sequences that get expanded as required:

- “$P” = current player name
- “$D” = current date (dd-mmm-yy)
- “$T” = current time (hhmmss)
- “$$” = a single dollar sign

The default pattern is “$P_$D-$T_1”.

Note the behavior in the following circumstances:

- When using $P, $D, and $T in the default clip name for consecutive Crash Records where the Crash Record dialog remains open between ingests, default clip names with a time suffix ($T$) are not incremented with the proper time of "now" for consecutive ingests. Instead they are auto incremented with a number and the suffix separator. Refer to the following table for examples of the naming behavior.

<table>
<thead>
<tr>
<th>Suffix Separator</th>
<th>Default Name</th>
<th>Resulting Sub Clip Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>- (dash)</td>
<td>$P-$D-$T</td>
<td>1st record = player-10-Jan-18-144500 2nd record = player-10-Jan-18-144500-1 3rd record = player-10-Jan-18-144500-2</td>
<td>Since the default name ends in a Date and Time, the entire name is preserved and the Suffix Separator is applied and incremented.</td>
</tr>
<tr>
<td>Blank - no value defined</td>
<td>Clip$P</td>
<td>1st record = Clipplayer 2nd record = Clipplayer1 3rd record = Clipplayer2</td>
<td>The base name “clipplayer” exists so the base name is used and incremented.</td>
</tr>
<tr>
<td>Blank - no value defined</td>
<td>Clip$D</td>
<td>1st record = Clip10-Jan-181 2nd record = Clip10-Jan-181 3rd record = Clip10-Jan-281</td>
<td>Since the default name ends in a Date and Time, the entire name is preserved and the Suffix Separator is applied and incremented.</td>
</tr>
<tr>
<td>_ (underscore)</td>
<td>$PClip</td>
<td>1st record = playerClip 2nd record = playerClip_1 3rd record = playerClip_2</td>
<td>The base name “playerClip” exists so the base name is used and incremented.</td>
</tr>
<tr>
<td>- (dash)</td>
<td>$DClip</td>
<td>1st record = 10-Jan-18Clip 2nd record = 10-Jan-18Clip-1 3rd record = 10-Jan-18Clip-2</td>
<td>This order preserves the Date part of the name, then applies an incremented value to the end.</td>
</tr>
</tbody>
</table>
## About the Automatic Renaming of Sub Clips Using Clip Patterns

- If a clip name has a time suffix, but not a date part, the time will be treated as a six-digit sequence number and auto incremented without the suffix separator. For this reason, Harmonic does not re-comment using default clip names with time suffixes only.

<table>
<thead>
<tr>
<th>Suffix Separator</th>
<th>Default Name</th>
<th>Resulting Sub Clip Name</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Blank - no value defined | STClip       | 1st record = 153 112Clip  
2nd record = 153 112Clip1  
3rd record = 153 112Clip2 | This order preserves the Time part of the name, then applies an incremented value to the end. |
| - (dash)           | Clip$T       | 1st record = Clip 153 112  
2nd record = Clip 153 113  
3rd record = Clip 153 114 | Since the name ends in just the time, the time value is seen as just a six digit number and is therefore incremented as a normal number. No suffix separator is used. |
Appendix B
Contacting the Technical Assistance Center

Harmonic Global Service and Support has many Technical Assistance Centers (TAC) located globally, but virtually co-located where our customers can obtain technical assistance or request on-site visits from the Technical Field Service Management team. The TAC operates a Follow-The-Sun support model to provide Global Technical Support anytime, anywhere, through a single case management and virtual telephone system. Depending on time of day, anywhere in the world, we will receive and address your calls or emails in one of our global support centers. The Follow-the-Sun model greatly benefits our customers by providing continuous problem resolution and escalation of issues around the clock.

Table B–1: For Distribution and Delivery (D&D, Legacy Harmonic) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 (888.MPEG.TWO) or 408.490.6477</td>
<td><a href="mailto:support@harmonicinc.com">support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EME</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>India</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:support.sm@harmonicinc.com">support.sm@harmonicinc.com</a></td>
</tr>
<tr>
<td>Africa</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:support.emea@harmonicinc.com">support.emea@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.6569.5580</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>

Table B–2: For Production and Playout (P&P, Legacy Omneon and Rhozet) Products

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 (888.MPEG.TWO) or 408.490.6477</td>
<td><a href="mailto:omneon.support@harmonicinc.com">omneon.support@harmonicinc.com</a></td>
</tr>
<tr>
<td>EMEA</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:omneonemeasupport@harmonicinc.com">omneonemeasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.6569.5580</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>
The Harmonic Inc. support website is:
http://www.harmonicinc.com/content/technical-support

The Harmonic Inc. Distribution and Delivery product software downloads site is:
ftp://ftp.harmonicinc.com

The Harmonic Inc. Playout and Production software downloads site is:

The Harmonic Inc. corporate address is:
Harmonic Inc.
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers for Harmonic Inc. are:
Tel. 1.800.788.1330 (from the U.S. and Canada)
Tel. +1.408.542.2500 (outside the U.S. and Canada)
Fax.+1.408.542.2511